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Resumo 

A plasticidade é o processo através do qual os neurónios adaptam a sua forma e 

função a estímulos externos e é um processo crítico para o desenvolvimento, 

aprendizagem e memória. Novas descobertas indicam que a formação de novas 

estruturas sinápticas imaturas – ghost boutons (GBs) – em neurónios motores de 

Drosophila melanogaster (D. melanogaster) ocorre através de um mecanismo que 

nunca foi reportado na remodelação neuronal, chamado blebbing, em resposta a 

estímulos agudos que mimetizam elevada atividade sináptica. Foi demonstrado que a 

actina não contribui para a iniciação e crescimento do processo de formação de novos 

botões sinápticos por blebbing sendo necessária em estágios posteriores de 

desenvolvimento, como a estabilização e maturação dos GBs. No entanto, o papel 

específico dos outros elementos do citoesqueleto, como os microtúbulos (MTs), neste 

processo permanecem pouco compreendidos. Assim, este estudo visa caracterizar a 

dinâmica dos MTs na formação e crescimento de GBs em D. melanogaster. 

Neste estudo foram usadas técnicas de manipulação genética, incluindo knockdown 

e sobre-expressão de proteínas de ligação a microtúbulos, e coloração imuno-

histoquímica de α- e β-tubulina. Larvas de D. melanogaster no terceiro estadio foram 

estimuladas com um protocolo intervalado rico em potássio e cálcio para induzir a 

formação de GBs adicionais. Para explorar melhor a dinâmica dos MTs foi utilizado o 

taxol, um agente estabilizador, e a vinblastina, um desestabilizador, para manipular a 

estabilidade dos MTs durante o desenvolvimento dos GBs. 

A marcação de α- e β-tubulina revelou mudanças dinâmicas na estabilidade dos MTs 

dentro dos GBs. Não obstante, o tratamento com taxol levou a uma redução significativa 

no número de GBs, no entanto, os GBs remanescentes eram maiores e continham 

frequentemente uma alta intensidade da proteína estabilizadora Futsch, sugerindo que 

a estabilização dos MTs pode inibir a formação inicial dos GBs, mas promover o 

crescimento de botões maduros. Por outro lado, o tratamento com vinblastina não 

alterou significativamente o número de GBs, indicando que a desestabilização completa 

dos MTs pode interferir com o processo de maturação, sugerindo que um certo grau de 

estabilização dos MTs pode ser necessário para a maturação dos GBs. 

EB1, uma proteína que associada ao extremo positivo dos MTs, estava presente em 

todos os GBs, o que provavelmente aponta para o seu envolvimento na iniciação do 

processo de blebbing e que a polimerização dos MTs pode estar a ocorrer durante o 
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desenvolvimento dos GBs. As proteínas Futsch e Short-Stop, que ajudam a estabilizar 

os MTs, exibiram resultados semelhantes em relação à sua presença nos GBs e à 

diminuição do número de GBs quando a sua expressão foi reduzida, destacando os 

seus papéis na promoção da estabilidade dos GBs e na integridade dos MTs, indicando 

que são cruciais para o processo de blebbing. Por fim, a subunidade da proteína de 

clivagem Katanin-60 desempenhou um papel crítico no desenvolvimento dos botões, 

uma vez que níveis reduzidos de Katanin-60 resultaram numa diminuição do número de 

GBs, sublinhando a importância da fragmentação controlada dos MTs para a formação 

e manutenção adequadas dos GBs. 

Assim, as nossas descobertas destacam o papel crucial da dinâmica dos MTs na 

formação dos GBs, sugerindo que tanto os estabilizadores dos MTs como as proteínas 

de clivagem estão envolvidos na plasticidade sináptica. Estas descobertas podem 

fornecer informações relevantes sobre possíveis abordagens terapêuticas para doenças 

neuro-degenerativas ligadas à disfunção sináptica, como a Esclerose Lateral 

Amiotrófica e a Doença de Alzheimer. 

Estudos futuros, incluindo live imaging e análise comportamental, bem como a 

avaliação do mecanismo compensatório entre Tau-Spastin, são necessários para 

elucidar os processos exatos subjacentes ao envolvimento dos MTs na formação e 

crescimento dos GBs. 
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Abstract 

Plasticity is the process through which neurons adapt their shape and function to 

external stimuli and is a critical process for development, learning, and memory. New 

findings indicate that the formation of new and immature synaptic structures – ghost 

boutons (GBs) – in motor neurons of Drosophila melanogaster (D. melanogaster) occurs 

through a mechanism that has never been reported in neuron remodeling, called 

blebbing, in response to acute stimuli that replicate conditions of high synaptic activity. It 

was shown that actin does not contribute to the initiation and outgrowth of new synaptic 

boutons by blebbing, being actin required in later stages of development like stabilization 

and maturation of GBs. However, the specific role of other cytoskeleton elements, such 

as microtubules (MTs), in this process remains poorly understood. Thus, this study aims 

to characterize the dynamics of MTs in the formation and growth of GBs in D. 

melanogaster.  

This study employed genetic manipulation techniques, including knockdown and 

overexpression of microtubule-binding proteins, and immunohistochemical staining for 

α- and β-tubulin. Third-instar D. melanogaster larvae were stimulated with a patterned 

high-potassium and calcium protocol to induce the formation of additional GBs. MT 

dynamics were further probed using taxol, a stabilizing agent, and vinblastine, a 

destabilizer, to manipulate MT stability during GB development.  

The labeling of α- and β-tubulin revealed dynamic changes in MT stability within GBs. 

Supporting this, taxol treatment led to a significant reduction in GB numbers, yet the 

remaining GBs were larger and often contained high intensity of the stabilizing protein 

Futsch, suggesting that MT stabilization may inhibit initial GB formation but promote the 

growth of mature boutons. Conversely, vinblastine treatment did not significantly alter 

GB numbers, indicating that complete MT destabilization may interfere with the 

maturation process, suggesting that a degree of MT stabilization may be required for GB 

maturation.   

EB1, a plus-end tracking protein, was present in all GBs possibly indicating its 

involvement in initiation of the blebbing process and that MT polymerization may be 

happening during GB development. Futsch and Short-Stop proteins, which help stabilize 

MTs, exhibited similar results regarding their presence within GBs and decrease in GB 

numbers when their expression is reduced, highlighting their roles in promoting GB 

stability and MT integrity, indicating that they are crucial for the blebbing process. Lastly, 
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the severing protein subunit Katanin-60, played a critical role in bouton development, as 

reduced levels of Katanin-60 resulted in a decrease in GB numbers, highlighting the 

importance of controlled MT severing for proper GB formation and maintenance.  

Thus, our findings highlight the crucial role of MT dynamics in GB formation, 

suggesting that both MT stabilizers and severing proteins are involved in synaptic 

plasticity. These findings might provide relevant insights into potential therapeutic 

approaches for neurodegenerative diseases linked to synaptic dysfunction, such as 

Amyotrophic Lateral Sclerosis and Alzheimer’s disease.  

Future studies, including live imaging and behavioral analysis, but also Tau-Spastin 

compensatory mechanism assessment, are needed to elucidate the exact processes 

underlying MT involvement in GB formation and outgrowth. 
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1. Introduction 

1.1. The nervous system 

The nervous system (NS) in vertebrates, and many invertebrates like Drosophila 

melanogaster (D. melanogaster), is divided into two main components: the Central 

Nervous System (CNS) and the Peripheral Nervous System (PNS).1 The vertebrate CNS 

consists of the brain and the spinal cord and serves as the primary control center for 

processing and transmitting information within the body. Meanwhile, the PNS comprises 

all the nerves (discrete bundles of axons) that branch out from the brainstem and spinal 

cord, connecting the CNS to the rest of the body and internal organs, facilitating 

communication and coordination.1 

Two major categories of cells compose the NS: neurons and glia. Neurons are the 

primary information messengers, while glia provides structural, metabolic, and signaling 

support to the brain. A typical neuron consists of the cell body (soma) that contains the 

nucleus, which controls cell's activities and contains its genetic material, and two kinds 

of cytoplasmic extensions – dendrites and axons. Dendrites, a series of branched 

processes, are usually closer to the soma and receive incoming information from other 

neurons or sensory receptors. The long, thin axon extends far beyond the soma and 

sends messages from the cell. At the end of the axons are presynaptic terminals and 

specialized structures, called synapses.1,2 

The synapse, a fundamental unit of communication within the nervous system, 

serves as a specialized junction facilitating the transmission of electrical and chemical 

signals between two neurons or between a neuron and an effector cell. This intricate 

process of synaptic transmission is crucial for the propagation of neural impulses. When 

an action potential (AP) reaches the axonal terminal of the presynaptic neuron, voltage-

gated calcium channels open, allowing an influx of calcium ions. This triggers the release 

of neurotransmitters (NTs) into the synaptic cleft. The NTs then bind to receptors on the 

postsynaptic membrane, inducing changes in the membrane potential of the 

postsynaptic cell. In summary, this process converts the electrical signal of APs into a 

chemical signal (NTs), which is then reconverted into an electrical signal through the 

activation of postsynaptic receptors, ensuring the transmission of information from one 

neuron to another, forming the basis for neural communication.1,3  
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1.2. Neuronal growth and plasticity  

During embryogenesis, neurons develop from neural progenitor cells within the 

neural tube, proliferating and differentiating into mature neurons.4 As developing neurons 

begin to form their intricate networks, the process involves specialized structures at their 

growing tips. When a neurite begins to grow, a growth cone-like protrusion extends from 

the cell body, supported by a network of microtubules (MTs) that stabilize the neurite and 

assist in membrane transport necessary for its elongation. The growth cone (GC), found 

at the tip of the advancing axonal neurite, is a highly active and adaptable structure. It 

displays dynamic behaviors such as the extension and retraction of filopodia and the 

active reshaping of lamellipodia, which contribute to its exploration of the surrounding 

environment. Guided by a combination of attractive and repulsive molecular cues, the 

GC helps neurons navigate through the embryonic environment in a highly coordinated 

manner, ensuring precise connections with their targets.5  

Once fully differentiated, most neurons enter a post-mitotic state and can no longer 

divide. Despite this, mature neurons must continually adapt to meet the specific demands 

of their targets and respond to stimuli received. This adaptability is mediated through a 

process called synaptic plasticity, where connections between neurons are modified in 

response to neuronal activity. Synaptic plasticity comprehends mechanisms such as 

dendritic remodeling, axonal sprouting, and activity-dependent strengthening or 

weakening of synapses. Initially, an excess of synaptic connections is formed, which are 

then pruned based on activity to ensure that only the most functional connections remain. 

These adaptive mechanisms are crucial for maintaining and fine-tuning neural network 

functionality throughout life, ensuring efficient information processing and response to 

environmental changes, as well as supporting learning and memory processes as it 

strengthens or weakens synaptic connections based on experience and activity.1,6  

Particularly, axons respond to CNS injuries by undergoing spontaneous axonal 

sprouting, a form of plasticity widely observed in animal models. According to Chen et 

al. (2014), in mammals this sprouting involves the growth of new branches from intact or 

injured axons near the lesion site, forming compensatory synaptic boutons, essential for 

restoring communication with target neurons that may have been affected by the injury, 

allowing re-establishment of functional neural circuits. Their formation and stabilization 

are driven by activity-dependent mechanisms, such as neuromuscular stimulation or 

rehabilitation therapies like treadmill training, which encourage not only the physical 

creation of new boutons but also enhance their functional contribution.7 These processes 



   

 

3 
 

emphasize that neuronal growth and plasticity are not static events but ongoing and 

finely regulated adaptations, necessary for both maintaining neural networks and 

facilitating recovery in the face of neural damage. 

A key player in synaptic plasticity in the CNS is glutamate which facilitates excitatory 

signaling between neurons, being crucial for modulating synaptic strength. It binds to 

specific receptors on the postsynaptic neuron, like NMDA (N-methyl-D-aspartate) and 

AMPA (α-amino-3-hydroxy-5-methyl-4-isoxazolepropionic acid) receptors, playing a 

crucial role in modulating synaptic strength. NMDA receptors are essential for long-term 

potentiation (LTP), which enhances learning and memory by strengthening synaptic 

connections. AMPA receptors mediate rapid synaptic transmission and contribute to both 

LTP and long-term depression (LTD), adjusting synaptic strength. Together, these 

processes support cognitive functions and the brain's adaptability to new information and 

experiences.8  

Failures in this plasticity mechanism can contribute to pathological conditions, leading 

to a variety of neurodegenerative diseases such as Alzheimer's disease (AD), where 

impaired plasticity affects cognitive function and disease progression.9,10 

1.2.1. Neuromuscular Junction 

Synapses typically form between neurons and are classified based on their 

connection points: axodendritic (axon to dendrite), axo-axonic (axon to axon), and axo-

somatic (axon to soma). Additionally, synapses can occur between motor neurons (MN) 

and skeletal muscle fibers, forming a synaptic contact known as the neuromuscular 

junction (NMJ), responsible for muscle contraction.11 

In the NMJ of vertebrates, the MN's axon terminal releases acetylcholine (ACh) 

packed in synaptic vesicles (SVs). Upon synaptic activation, in response to calcium 

influx, SVs rapidly fuse with the plasma membrane at specialized areas of the 

presynaptic membrane called active zones (AZs) and release ACh into the synaptic cleft. 

The ACh diffuses across the cleft and binds to specific postsynaptic receptors that are 

ligand-gated ion channels on the muscle cell membrane, causing changes in the ionic 

permeability and thus causing the membrane to depolarize, initiating an AP that leads to 

muscle contraction. This precise orchestration is essential for controlling voluntary 

muscle movements.12  NMJs provide reliable yet transient excitation of muscle cells to 

support movement, with each MN activating target muscle cells in response to changing 
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nerve activity patterns that reflect the organism's functional demands. As neuromuscular 

transmission is highly adaptable, the architecture of this synapse is also dynamic.13  

The NMJ is one of the best-studied and most disease-prone synapses in the NS 

making understanding its functions crucial for addressing disorders like Amyotrophic 

Lateral Sclerosis (ALS) or muscle dystonias.14 Its fundamental role in neuromuscular 

signaling is highly conserved across a wide range of animal species, from invertebrates 

to vertebrates.15 While much has been learned about postsynaptic morphogenesis using 

vertebrate NMJ models, considerably less is known about the mechanisms underlying 

presynaptic structural plasticity.16  

The mechanisms of plasticity are conserved across different species and model 

systems have proven valuable in understanding the dissection of molecular mechanisms 

of neuronal growth and plasticity. Historically, D. melanogaster has been one of the most 

commonly used models for studying these molecular mechanisms in neurobiology.17,18  

1.3. Drosophila melanogaster 

The first scientist to adopt D. melanogaster (also known as fruit fly) as a research 

organism was William Castle in 1900, and about a decade later a few other emeritus 

scientists followed his lead.19 Thomas Hunt Morgan, considered the founder of 

Drosophila genetics, later expanded on Castle's pioneer work, conducting 

groundbreaking research that established Drosophila as a model organism for genetic 

studies. Today, D. melanogaster continues to be a fundamental tool in genetic research 

due to its short generation time, large number of offspring, simple anatomy, cost-

effectiveness, and well-characterized genetic tools, making it very useful for studying 

fundamental biological processes and human genetic diseases.19,20  

The Drosophila genome shares around 60% homology with humans and has almost 

75% similarity in the genes that cause human diseases.19,21 In the third stage of 

development, the NMJ of D. melanogaster larvae is a stereotypical synapse, with well-

discernible boutons and robust structural plasticity.19,22–24 

As mentioned before, fruit fly has a short life cycle, with development from fertilized 

egg to adult taking 9 or 10 days at 25°C (or up to 19 days at 18°C). Embryogenesis takes 

approximately 24 hours, followed by three larval stages (first and second instar, each 1 

day; third instar, 2 days).19 Metamorphosis occurs within a puparium - a hard, protective 

chitin-based pupal case - where they remain for 4 to 5 days. At this stage, imaginal discs, 

formed during larval stages, differentiate into adult structures like eyes and wings. After 
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eclosion, adult flies emerge and reach sexual maturity within 8-12 hours, allowing rapid 

genetic studies due to their prolific reproduction and clear developmental stages.19 

The D. melanogaster larval neuromuscular system is relatively simple, with each 

abdominal hemisegment containing only 32 MNs. Its NMJs are individually specified, 

and easily accessible for visualization and recording. Specifically, muscle 6/7 has 

stereotyped and large synapses that are easy to visualize and quantify, this happens 

because this NMJ has twice as many boutons since it innervates two muscles.24,25 

Additionally, this system displays robust and reproducible changes in response to 

genetic or environmental manipulations, making it ideal for studying the mechanisms 

underlying synaptic growth and plasticity.25  

D. melanogaster’s NMJs have glutamatergic synapses rather than cholinergic ones 

and do not include muscle voltage-gated sodium channels unlike in vertebrate’s NMJs, 

leading to muscle contractions with varying intensity.23,24 Instead, muscle contraction in 

invertebrates is graded, meaning that the number of synapses present at each NMJ 

needs to be carefully controlled to assure maximal contraction capacity. Still, despite its 

simpler structure compared to the mammalian CNS, the fruit fly NMJ retains most key 

synaptic molecules conserved across species and is an excellent model not only for the 

study of muscle contraction but also as an excellent model for mammalian CNS 

glutamatergic synapses.26 

1.3.1. Drosophila genetic tools 

The establishment of stable genetic stocks represented a major advancement in the 

D. melanogaster genetic toolkit. One of the earliest and most significant innovations was 

the creation of balancer chromosomes that prevent genetic recombination during 

meiosis, which is crucial for preserving mutations that would normally be lost due to their 

lethal or sterile effects. These chromosomes often carry distinct visible physical traits, 

making it easy to identify flies that have them. Moreover, the distinctive structure of 

balancer chromosomes, which includes multiple inversions, ensures that any offspring 

resulting from recombination events are not viable. This prevents the introduction of 

unwanted genetic variations and allows researchers to maintain stable populations with 

specific genetic traits.19,21 

Another main tool in Drosophila research is the GAL4-UAS system. This method 

allows scientists to activate the expression of specific genes in particular tissues or at 

specific times. The system consists of two parts: the GAL4 protein, which binds to a 
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specific DNA sequence known as the Upstream Activating Sequence (UAS), and a 

separate genetic construct that contains the UAS sequence linked to a gene of interest. 

By placing, the GAL4 gene under the control of a tissue-specific promoter in one fly strain 

and the UAS-gene construct in another, researchers can cross these flies to create 

offspring in which the gene of interest, often linked to a fluorescent marker, is expressed 

only in the desired tissue. This system has been essential in studying the roles of 

individual genes in various biological processes.19,21,27  

Furthermore, the GAL4-UAS system can be coupled with RNA interference (RNAi) 

by expressing short inverted hairpins that target specific genes to reduce or “knockdown” 

the expression of the gene’s messenger RNA. Thus, researchers can study the effects 

of reduced gene function in a controlled and targeted way.19 

1.3.2. Neuronal Growth and Synaptic Plasticity at the Drosophila NMJ 

In the initial 10 hours of embryonic development in D. melanogaster, neuroblasts 

segregate and differentiate into glial cells and neurons, forming the neuroectoderm. Over 

the next 3 hours, MN axons leave the CNS and extend towards target muscles to make 

synaptic connections, through GCs.24,28 At the larval NMJ, the presynaptic bouton 

becomes surrounded by a membranous structure that folds inward known as 

subsynaptic reticulum (SSR), which contains glutamate receptors, scaffolding proteins, 

and postsynaptic signaling complexes. After embryogenesis, NMJs adapt to patterns of 

neuronal activity that refine their final morphology (Figure 1.1A). This refinement involves 

increasing the number of boutons and AZs to match the rapid growth of muscle fibers. 

The addition of new boutons can occur by division of existing boutons, either by 

asymmetric budding or symmetric division, but in some cases, boutons can emerge de 

novo from the axonal membrane.24 However, throughout NMJ development, as the 

terminal arbor grows and matures not all structures undergo stabilization, some synaptic 

connections are removed and “pruned” (Figure 1.1B).16 Thus, by the end of embryonic 

development, functional NMJs, each containing a few synaptic boutons, have formed on 

each muscle fiber. 
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Essentially, 3 types of synaptic boutons innervate D. melanogaster NMJ: Type I, Type 

II, and Type III (represented in Figure 1.2A and 1.2B). They differ in size, morphology, 

physiology, type of NT released, and the amount of SSR that surrounds them. Type I 

boutons, which are glutamatergic, include both Ib (big) and Is (small) categories. Type II 

and III boutons are modulatory, lack SSR, and use different NTs. A third instar larva NMJ 

is composed by Type I boutons (roughly 20-50 on each muscle in a typical larvae).24 

In addition to the structural changes that result from muscle size expansion, 

Drosophila NMJs can also undergo plastic changes in response to short-term 

perturbations of neuronal and muscle activity.24  

A B 

Figure 1.1 - NMJ expansion and process of terminal bouton formation and maturation. (A) 

Schematic of NMJ development to demonstrate arbor growth and bouton addition during larval 
development. (Adapted from Menon et al., 2013) (B) Developmental signaling or synaptic activity can induce 
the formation of new boutons that can stabilize and mature or be retracted. (Adapted from Vactor et al., 
2017) 

 

B A 

Figure 1.2 - Types of boutons at the Drosophila larval NMJ (A) Anti-HRP labels the presynaptic 

neuronal membrane and allows visualization of all bouton types. Type Ib, Is, II, and III boutons are indicated 
by arrows. Type Ib and type Is boutons differ in size, morphology, physiology, and the amount of SSR (Dlg 
staining) that surrounds them. Dlg is absent from type II and III boutons. (B) A schematic representation of 
differences in the bouton types seen in (A). Other than the size and morphological differences, the boutons 
also differ in the NT utilized. (Adapted from Menon et al., 2013) 
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1.4. Ghost boutons in D. melanogaster’s NMJ 

Studies on D. melanogaster’s NMJ have revealed the rapid formation of nascent 

synaptic structures in response to patterned depolarization induced by high potassium 

(K+) solution. These structures, known as ghost boutons (GBs), represent immature 

structures, that form as a result of rapid activity-dependent synaptic plasticity.29 GBs 

have SVs and sometimes AZs as pre-synaptic markers, however, they lack post-synaptic 

machinery, and so, for confocal microscopy GBs can be recognized because they 

express a presynaptic neuronal membrane marker recognized by the anti-Horseradish 

Peroxidase (HRP) antibody but lack the post-synaptic scaffold protein Discs-large (Dlg) 

marker24,30, as represented in figure 1.3A. Despite their rapid formation, GBs require 

further maturation to become fully functional (see Figure 1.3B).  This process involves 

the assembly of AZs in the GB and post-synaptic specializations, including clusters of 

glutamate receptors, which are crucial for synaptic transmission.24 Without proper 

stabilization, these newly formed boutons may be retracted or degraded by muscle and 

glia-mediated mechanisms.31  

B A 

Figure 1.3 – Ghost boutons and their maturation. (A) Confocal image of a D. melanogaster NMJ. 

Anti-HRP labels the presynaptic neuronal membrane (white). In GBs (see arrowheads) is possible to verify 
the absence of anti-Dlg marker.(B) Schematic of activity-induced bouton formation and subsequent 
maturation progression. (Adapted from Fernandes et al., 2023) 

A 
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The formation of new boutons in MN of D. melanogaster in response to this acute 

synaptic activity occurs through a mechanism previously observed only in migratory cells 

and which has never been reported in neuronal remodeling, called blebbing. Blebs at the 

NMJ are pressure-induced membrane protrusions that result from the interaction of 

mechanical forces between the MN and the muscle (muscle contraction) that promote 

the growth of new boutons.32 

The cytoskeleton plays a critical role in maintaining and shaping neuronal 

morphology. Components like actin filaments and MTs provide structural support and 

facilitate the dynamic remodeling of neurons, enabling processes such as synaptic 

growth, stabilization, and intracellular transport.1 Interestingly, Fernandes et al. (2023) 

demonstrated that bouton outgrowth in response to acute synaptic activity does not rely 

on actin polymerization; instead, actin is required for bouton stabilization.32 However, the 

mechanisms that control the development of this boutons in MN, how they interact with 

other cytoskeletal elements - such as MTs - in this process to facilitate the morphological 

changes necessary for their formation, as well as their coordination with other cell types, 

such as muscles and glial cells, are still open questions.32,33  

1.5. Microtubules: Structure, Neuronal Polarity, and 

Neuronal Stability  

Like all eukaryotic cells, neurons rely on three major cytoskeletal elements for 

structural integrity and motility: MTs, actin filaments, and intermediate filaments.1 MTs, 

in particular, play a vital role in intracellular transport, cell division, motility, and the 

maintenance of cell shape. Their structure consists of dynamic polymers formed by α- 

and β-tubulin dimers. Each MT is composed of 10 to 15 protofilaments (13 in both 

Drosophila and mammalian cells) assembled in a cylindrical arrangement with a hollow 

core, forming long tubular structures with an average exterior diameter of 25nm, 

represented in figure 1.4A.1,34  

MTs are polar structures that have a plus-end and a minus-end with distinct 

properties. The α-β tubulin heterodimer gives the MT an intrinsic polarity with a plus (β-

tubulin) and a minus (α-tubulin) end. This polarity is important to determine the direction 

of movement along MTs.1,34,35 

MT can be either stable or dynamic, depending on the physiological situation. 

Dynamic MTs, in contrast to stable MTs, have the ability to undergo stochastic transitions 

between phases of depolymerization and polymerization.34 Dynamic instability, 



   

 

10 
 

described by Tim Mitchison and Marc Kirschner in 1984, results in rapid cycles of growth 

and shrinkage at the plus-ends with half-lives of only several minutes within the cell, 

while the minus-ends tend to shrink slowly without stabilization.36  

When polymerization occurs, a new dimer is added to the plus-end where the α-

tubulin of the new dimer contacts the nucleotide exchangeable site (E site) of the 

previous β-tubulin, triggering guanosine triphosphate (GTP) hydrolysis and forming a 

GTP cap that stabilizes the MT, as shown in figure 1.4B. Loss of this GTP cap leads to 

rapid depolymerization as guanosine diphosphate (GDP)-tubulin subunits are released. 

The MT lattice primarily consists of GDP-bound tubulin. At the minus end, the E site of 

the incoming dimer contacts the catalytic region of the terminal subunit, preventing a 

GTP cap and making the structure more prone to depolymerization.34,37 

1.5.1. Microtubule polarity in neurons 

Most differentiated neurons have one long axonal process and several branches, 

which strongly depend on MTs for their integrity and organelle transport. In most non-

neuronal cells, the more dynamic plus-ends of MTs point toward the periphery, whereas 

minus-ends, stabilized by a ɣ-tubulin cap, are usually at the center of the cells anchored 

in microtubule organization centers (MTOCs) such as the centrosome.38 However, the 

Figure 1.4 - MT structure and dynamics. (A) MT structure. Tubulin heterodimers with α- (blue) and 

β-subunits (green) assemble into protofilaments. 13 parallel protofilaments form a 25 nm hollow cylinder, 
with β-tubulin at the plus end and α-tubulin at the minus-end. (B) Cartoon showing MT dynamic instability 
intermediates. The polymerization–depolymerization cycle is driven by GTP hydrolysis and GDP/GTP 
exchange, leading to catastrophe and rescue events. GTP bound to α-tubulin (N site) is non-hydrolyzable 
and non-exchangeable, while GTP on β-tubulin (E site) can be hydrolyzed and swapped with free GDP. A 
GTP cap, rich in GTP-bound β-tubulin (purple), forms during polymerization due to delayed GTP hydrolysis. 
(Wang et al., 2023) 

B A 
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MT orientation is more complex in neurons, where it contributes to the distinction 

between dendrites and axons.1,39  

While the majority of MTs in proximal dendrites have their plus-ends directed toward 

the cell body, distal dendrites display a more mixed orientation. This mixed polarity is 

essential for the bidirectional transport of molecules and organelles within dendrites, 

supporting synaptic plasticity and other dendritic functions.1,37,40 

On the other hand, in axons, MTs are uniformly oriented with their plus-ends directed 

towards the axon terminal. This uniform orientation facilitates the directional transport of 

organelles, vesicles, and proteins necessary for synaptic function and maintenance. The 

motor proteins kinesin (plus-end directed) and dynein (minus-end directed) utilize this 

polarity to transport ion channels, NT vesicle precursors, and other synaptic components 

towards the axon terminal (anterograde transport) or the cell body (retrograde transport), 

respectively. In MN, proper transport is essential to support rapid synaptic signaling and 

the propagation of APs, as well as maintaining cellular homeostasis.41–43  

In contrast, for some invertebrates like D. melanogaster, the MN is a bipolar neuron, 

and consequently, dendrites appear to not have mixed polarity, but rather have mostly 

minus-end-out MTs whereas axons, like in mammals, have plus-end-out MTs. Therefore, 

although details may differ, both vertebrate and invertebrate neurons share the same 

principle that dendrites and axons vary in their MT orientantion.1 

During neuronal development, the axon terminal does not have well-defined boutons, 

but a GC instead, as mentioned before. The GC uses mostly dynamic remodeling of the 

actin cytoskeleton using lamellipodia and filopodia to probe its surroundings and drive it 

forward. Once a positive cue is sensed, dynamic MTs found in the central domain of the 

GC invade these actin-rich filopodia and become stabilized, forming a connection with 

the target. Therefore, MTs have been considered secondary players, invading the 

peripheral domain only where the actin cytoskeleton allows them to go.44,45 However 

recent insights reveal that MT-based motor proteins, such as dynein and kinesins, may 

be essential as well. These motor proteins can generate forces that enable MTs to invade 

the peripheral domain of the GC (see figure 1.5A). By coordinating the distribution and 

alignment of MTs, dyneins and kinesins can ensure their polarized invasion into one side 

of the GC's peripheral domain, effectively instructing the cone to turn and thereby 

ensuring accurate axon guidance (see figure 1.5B).46 This highlights not only the critical 

role of MTs in axon guidance, but also in precise neural circuit formation, which is 

fundamental to proper neuronal connectivity and function. 
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Thyagarajan et al. (2022) elucidate the pivotal role of MT polarity in driving neuronal 

polarity, demonstrating that it serves as a master regulator of key intracellular processes 

in neurons. Their research using Drosophila sensory neurons revealed that altering MT 

polarity can significantly impact the identity and function of neuronal compartments. 

Specifically, dendrites that adopt an axonal-like plus-end-out MT polarity show a marked 

shift in cargo distribution, with a reduction in ribosomal content typical of dendrites and 

an increase in axonal markers. Furthermore, these dendrites exhibit enhanced MT 

stability and even develop ectopic diffusion barriers akin to those at the axon initial 

segment. Despite these profound changes in intracellular organization, the overall 

dendritic morphology and branching patterns remain relatively unchanged, suggesting 

that while MT polarity dictates functional and structural aspects of neuron compartments, 

the external shape of neurons is resilient to such internal shifts. This study highlighted 

the central role of MT polarity in coordinating the complex internal architecture that 

supports neuronal function and polarity.40 

1.5.2. Microtubule stability in neurons 

The balance between MT stability and instability is essential in neurons, as it supports 

the structural integrity required for maintaining axonal transport, neuronal shape, and 

synaptic function, while also allowing for the flexibility needed for growth, repair, and 

Figure 1.5 - Motor driven forces in the growth cone. (A) As the GC advances, cytoplasmic dynein 

generates forces on MTs, helping some resist the retrograde flow of the actin cytoskeleton in the peripheral 
domain. Kinesin-5 and kinesin-12 generate opposing forces to dynein, resisting MT entry into the 
peripheral domain. Kinesin-5 acts mainly in the transition zone, while kinesin-12 operates more in the 
filopodia. (B) During GC turning, kinesin-5 and kinesin-12 forces shift to the side opposite the turn, allowing 
MTs to enter the side of the GC that follows the direction of the turn. (Adapted from Khan and Baas, 2016) 
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synaptic plasticity. Disruptions in this balance can lead to significant neurological 

disorders and impairments in cognitive function.47  

In proliferating and developing cells, most MTs are highly dynamic, but in 

differentiated neurons, many MTs become stabilized due to their interactions with 

structural Microtubule-binding proteins (MTBPs), which will be approached in more detail 

on chapter 1.6.1. The stability of MTs is also linked to post-translational modifications 

(PTMs), such as acetylation, detyrosination, and phosphorylation, with the majority of 

modified tubulin subunits found in the more stable, or long-lived, MT populations.40 

A study conducted by Cappelletti et al. (2021) highlights the critical role of MT 

acetylation, particularly the acetylation of α-tubulin at lysine 40, in maintaining MT 

stability within neurons. The researchers found that this PTM is essential for the 

structural integrity of MTs, making them more resilient to mechanical stress and crucial 

for sustaining the complex architecture of neurons, including long axons and intricate 

dendritic trees. Moreover, acetylated MTs play a key role in regulating MT dynamics by 

reducing excessive instability, thereby preventing issues such as axonal over-branching. 

These findings emphasize the importance of acetylation in not only stabilizing MTs but 

also in supporting the overall functional and structural stability of neurons, which is 

particularly relevant in the context of neurodegenerative diseases where MT stability is 

often compromised.48 

In addition to the effects of PTM, various drugs are known to either stabilize or 

destabilize MT stability in neurons. Vinca alkaloids are a class of chemotherapy drugs 

derived from the plant Catharanthus roseus. Common vinca alkaloids include vincristine, 

vinblastine, and vinorelbine. They work by binding to tubulin dimers, preventing MT 

polymerization, which is crucial for cell division. This action disrupts the mitotic spindle, 

halting cell division and leading to cell death, and for that reason, they are used in 

chemotherapy in various cancers like leukemia, lymphoma, and lung cancer. Another 

class of drugs that binds specifically to MTs are taxanes, like taxol (paclitaxel), but rather 

then inhibiting MT assembly, stabilizes it instead. By stabilizing MTs in place, taxanes 

disrupt the mitotic spindle, blocking cell division, leading to cell cycle arrest and 

apoptosis, and thus taxol is used as an anticancer agent as well as an experimental 

tool.34,40 However, it is worth mentioning that both types of drugs have been observed to 

adversely impact peripheral nerve function when administered as part of chemotherapy 

treatments, with patients frequently developing peripheral neuropathy as a result.49 



   

 

14 
 

Interestingly, MT stabilization is sufficient to induce axon formation, as neurons 

treated with low doses of taxol extended axon-like neurites that displayed a high ratio of 

acetylated to tyrosinated tubulin, a proximo-distal Tau gradient and the absence of 

MAP250 (two proteins associated with MTs, explained in further detail in chapter 1.6.1.). 

1.6. Microtubule-binding proteins in neurons 

 A protein is considered a MTBP if experimental data demonstrate its ability to bind 

to MTs. MTBPs can be categorized into multiple families, according to their activity and 

location such as stabilizers, destabilizers, cytoskeletal integrators, minus end-targeting 

proteins, plus-end trafficking proteins, etc.51 

1.6.1. Stabilizers 

The stabilizer proteins promote polymerization and/or slow depolymerization. Some 

examples of this kind of proteins in mammals are the Microtubule-Associated Proteins 

(MAPs) such as MAP1A, MAP1B, MAP2, and Tau. Overall, MAPs contribute to the 

structure and organization of MTs and are involved in regulating a range of processes 

associated with MTs, such as axonal transport.51,52 MAP1A and MAP2 (which is mostly 

found in dendrites) have also been implicated in dendritic differentiation and 

maintenance.37 However, in D.melanogaster there is no direct homologs for these 

proteins.53,54  

Regarding MAP1B protein, it is primarily expressed in the axons of developing 

neurons during embryogenesis but is also present in adult neurons. Evidence from 

multiple studies indicates that MAP1B is a negative regulator of axon branching in both 

adults and embryonic neurons.55,56 It interacts with actin filaments and MTs, with binding 

regulated by phosphorylation.52 In D. melanogaster, Futsch, which is the MAP1B 

ortholog, is necessary for axonal growth and dendritic morphology. This protein 

associates with MTs (Figure 1.6A) and outlines cytoskeletal loops that span the edges 

of mature and stable synaptic boutons (Figure 1.6A and B). During synaptic plasticity 

and new bouton formation induction, the architecture of the MT loops in the mature 

boutons suffers a significant rearrangement, and research indicates that Futsch is crucial 

for this process. After the formation of the new boutons the structure of the mature bouton 

goes back to normal, with a Futsch loop in it.57,58 Mutations in the Futsch gene lead to 

disorganized synaptic MTs, a decrease in the total number of boutons in the NMJ, and 

an increase in their size. Overexpressing a domain of Futsch related to MAP1B can 
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partially reverse these defects. Additionally, increasing nerve-terminal branching through 

genetic manipulation correlates with enhanced formation of synaptic MT loops, a process 

that depends on normal Futsch activity.58 

Futsch is also associated with fragile X syndrome, a genetic disorder causing mental 

retardation, linked to disruptions in synaptic function. In a study by Zhang et al. (2001), 

the Drosophila Fragile X-related gene (dfxr) was identified as a critical negative regulator 

of synaptic plasticity through its repression of Futsch. This relationship controls the 

structure of synapses at NMJs.28 When dfxr is lost or mutated, its normal repression of 

Futsch is removed, leading to excessive Futsch protein levels and causing significant 

synaptic overgrowth28, resembling Futsch overexpression58. Furthermore, dfxr Futsch 

double mutants restored normal synaptic structure and transmission, highlighting the 

importance of MT regulation in synaptic plasticity.28 

In the mature brain, Tau is predominantly expressed in neurons, where it is 

preferentially located in axons. The major role of this protein in the CNS is to promote 

MT assembly and stability, although this interaction can be inhibited by phosphorylation 

at specific sites.59,60 However, Tau has other roles in addition to its association with MTs, 

including regulation of neuronal plasticity, nucleolar organization, DNA protection against 

oxidative stress61, and it is also involved in neurite polarity, axon elongation, and axonal 

transport.60 Dysfunction of Tau has unequivocally been shown to be able to cause 

neurodegeneration and its abnormal accumulation leads to intracellular fibrillary deposits 

in neurons and glial cells of a large variety of disorders today collectively referred to as 

Figure 1.6 – Futsch loops in stable boutons.  (A) Colocalization of anti-Futsch (green in A1) with anti-

α-tubulin (red in A2) at a synaptic terminal (merged image in A3). (B) Futsch loops. Increase in Futsch loops 
(green in B1) due to a postsynaptic protein overexpression (flexin) (B2 merged image with 
antisynaptotagmin). 22C10 is a monoclonal antibody against Futsch. (Adapted from Roos et al., 2000) 
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Tauopathies that include frontotemporal dementia, AD and synucleinopathies such as 

Parkinson's disease.60–62 

1.6.2. Destabilizers 

Microtubule-destabilizing proteins contribute to the loss of tubulin dimers from MTs. 

They function by either inhibiting the addition of new dimers to the polymer, inducing 

catastrophes at MT ends, or severing MTs into smaller segments. These events are 

required within neurons to remodel the MT cytoskeleton for proper synapse formation 

and branching. Examples of destabilizing proteins that sever MTs in an ATP-dependent 

manner include Katanin and Spastin. These proteins are MT-severing proteins found in 

a wide range of organisms.51,63 P60-Katanin is more highly expressed in the neuron, but 

Spastin is more concentrated at sites of branch formation. Thus, Spastin is particularly 

effective at promoting axonal branching by generating short MTs concentrated at branch 

sites, being that its overexpression enhances axonal branching, whereas overexpression 

of P60-Katanin does not.64 Katanin is composed of P60 and P80 subunits and has a 

more complex role. P60 severs MTs, while P80 modulates this activity.65 Overexpression 

of P60-Katanin significantly reduces MT mass and process length, particularly during 

early neuronal development in cultured hippocampal neurons. P80 overexpression, on 

the other hand, leads to milder severing effects and an increase in process number, 

suggesting a regulatory role in modulating P60 activity.65  Recent findings point out that 

Katanin also plays a key role in synaptic plasticity by regulating both the structural 

remodeling of dendritic spines and the functional potentiation of synapses during LTP. 

Inhibition of Katanin impairs MT growth and prevents activity-induced spine remodeling 

without affecting overall spine density. Katanin also facilitates MT invasion into synaptic 

spines, a process critical for the dynamic restructuring required for synaptic strength and 

adaptability.66  

Spastin, on the other hand, appears to be a negative regulator of bouton growth, 

where Spastin mutant NMJs show a decrease in bouton size but a slight increase in the 

number of boutons.67 The work by Ozdowski et al. (2011) indicate that loss of Spastin 

reduces the distal MT network and causes bunched synaptic boutons, enhancing 

spontaneous NT release slightly, but reducing AP-evoked NT release, and mutations in 

Spastin lead to significant synaptic abnormalities, including altered bouton morphology, 

disrupted MT distribution, and impaired synaptic transmission.68 A recent study revealed 

that Spastin has a dual role in MT dynamics. While it severs MTs into shorter pieces, it 

also stabilizes and promotes their growth by slowing shrinkage and increasing rescue 
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events. This paradoxical effect results in an overall increase in MT number and mass, 

as the fragments grow and accumulate. A mathematical model revealed that Spastin 

shifts MTs into a state with a positive net tubulin flux, which explains the observed 

increase in MT mass and helps resolve the apparent contradiction of severase activity 

leading to more MTs.69 In Drosophila, overexpression of Spastin also reduces synaptic 

efficacy and causes loss of acetylated MTs within neurons and specifically at NMJ 

presynaptic terminals.70 

Yu et al. (2008) reported that Tau acts as a protective agent against MT severing by 

P60-Katanin more so than by Spastin. Axons that are depleted of Tau display a greater 

tendency to form branches, supporting the idea that Tau's presence inhibits MT severing 

by P60-Katanin. Furthermore, in neurons lacking Tau, Spastin's effect on MT severing 

and axonal branching remains significant, indicating that Spastin's function is less 

dependent on Tau's presence compared to P60-Katanin.64 This might suggest that there 

are at least two branch formation mechanisms through MT severing, one based on the 

local concentration of Spastin and another based on the detachment of Tau from MTs. 

However, this is not the only MT stabilizer protein that correlates to MT severing proteins. 

It might be expected that reduced Spastin activity would lead to less MT severing, 

resulting in higher Futsch labeling. Instead, both Futsch and tubulin staining are lower at 

NMJs in Spastin mutants, particularly at terminal boutons67. This suggests that MT 

severing into smaller fragments may actually enhance the transport of MTs from the axon 

into the NMJ.67 

Additionally, it is worth noting that: 1) the majority of autosomal dominant hereditary 

spastic paraplegia - a progressive neurodegenerative disease that primarily affects the 

distal ends of the longest motor axons of the CNS – mutations are located in Spastin68, 

and 2) downregulation of Spastin prevents loss of MTs and missorting of Tau, two key 

events in Alzheimer pathology. This indicates that Spastin or upstream regulators of 

Spastin activity could serve as therapeutic targets for AD and related Tauopathies.71 

1.6.3. Plus end-tracking proteins 

Unlike other MAPs, MT plus-end tracking proteins (+TIPs) associate specifically with 

the polymerizing plus-end of MTs where they act as regulators of MT dynamics and MT 

interactions with other structures72, such as actin filaments (explained in greater detail in 

the next chapter). This group exhibits significant structural and functional diversity and 

includes some of the most conserved and important polymerization-MTBPs, though not 
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all +TIPs promote polymerization; some, like kinesin-13, induce depolymerization.51 

Based on current understanding, +TIPs association with MTs suggests that they can 

generally be divided into: End-binding proteins (EBs) (EB1 to EB3 in mammals); EB-

dependent +TIPs, such as cytoplasmic linker protein (CLIP) 170 and CLIP-associated 

proteins (CLASPs), and EB-independent +TIPs51,72, like spectraplakins which will be 

further explained in chapter 1.6.4.  

EB proteins bind independently to the growing MT plus-ends, which they can 

recognize by sensing the nucleotide-bound state of β-tubulin. Once attached, EBs can 

recruit other +TIPs, acting as coordinators for a protein interaction network at growing 

MT plus-ends. Some of these recruited proteins significantly affect the dynamic 

properties of MTs, suggesting that disruptions in cellular MT dynamics following EB loss 

of function are primarily due to defects in the recruitment of these proteins.73 

As key regulators of MTs, +TIPs are great candidates to control MTs and relay their 

signals during neuronal development and homeostasis. Multiple +TIPs have already 

been linked to neurodevelopmental functions. For instance, EBs, CLIP-170, CLASPs 

and spectraplakin are reported to be involved in axon outgrowth, with EBs and CLIP-170 

also implicated in dendritic outgrowth and axon formation.72  

MAPs on the MT lattice can also contribute to the regulation of +TIP binding. 

Research has shown that MAP1B functions as a direct regulator of EB1/3 by 

sequestering EB1/3 in the cytosol and anchoring them to the MT lattice, which effectively 

reduces the concentration of EBs at the MT plus-end, consequently fine-tuning axon 

growth.74  Similarly, MAP2 can also attract EBs to the MT lattice in dendrites when 

synaptic stimulation occurs.75 Additionally, recent findings suggest that Tau can also 

recruit and immobilize EB1/3 but to MT bundles instead, likely contributing to the 

stabilization of these structures, where high Tau concentrations lead to EB 

immobilization along the MT lattice in cell culture.75 Conversely, MAP1B is present at one 

stage of neuronal development, and Tau appears at a subsequent stage. This sequential 

expression suggests that their functions are not overlapping but are part of a 

developmental progression. Nonetheless, while MAP1B was reported to increase the 

binding of EB1/3 to MTs plus-ends when being downregulated and thus negatively 

regulating these proteins with MTs, when Tau is knocked down there is a significant 

reduction in the number and length of EB1/3 comets at MT plus-ends.74 
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Mutations in +TIPs or their misregulation are associated to multiple 

neurodevelopmental and neurodegenerative diseases like AD, ALS and certain forms of 

autism.72 

1.6.4. Cytoskeletal integrators 

Proteins known as cytoskeletal integrators bind to and/or modulate MTs alongside 

other cytoskeletal elements, such as actin. Effective interaction between the actin and 

MT systems is crucial for processes like cell division and maintaining cell polarity. This 

diverse category includes scaffolding proteins like cancer-associated protein APC, and 

members of the plakin family.51 In plakin family, spectraplakins are an important member 

of this category, which are particularly versatile cytoskeletal integrators.  

Spectraplakins contain three specific domains: one that binds to actin, another that 

associates with the MT plus-end through EBs, which is why spectraplakin proteins can 

also fall into the +TIPs category, and a third that binds and stabilizes MTs, just like other 

MAPs and Tau. Spectraplakin deficiency causes very strong MT phenotypes correlating 

with neuro-development disorders as well as severe neurodegeneration in mice and 

humans.76 Examples of spectraplakins include microtubule actin cross-linking 1 (MACF1) 

in mammals and Short-Stop (Shot) in Drosophila.77  

MACF1 is known to guide MTs along actin filaments and to mediate MT capture at 

actin-rich sites near the membrane.72 In neurons, MACF1 stabilizes MTs and coordinates 

their interactions with the actin cytoskeleton, enabling efficient axonal growth and 

maintenance. Loss of MACF1 leads to reduced axon length and defects in axon 

guidance, demonstrating its role in shaping the neural architecture. Moreover, through 

its association to MTs and EBs, spectraplakins regulate synaptic stability, ensuring 

proper synaptic transport and plasticity. In Drosophila, on the other hand, Shot 

coordinates MT reorganization necessary for synapse formation and maintenance, 

promoting synaptic growth during both development and aging. Shot also links MTs to 

the actomyosin network during important developmental processes, such as the 

formation of neural circuits, essential for adaptive neural plasticity.78  

Additionally, this group can encompass even classic MAPs such as Tau, since 

studies have showed that Tau colocalizes with both stable and dynamic MTs as well as 

with actin filaments.79,80 Furthermore, Tau neurotoxicity correlates with alterations of 

actin organization in animal models of AD.81 Overall, the evidence supports that Tau acts 
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as a regulator of MTs and actin, suggesting that Tau is a potential linker between the two 

cytoskeletons. 

1.6.5. Minus end-targeting proteins 

During the early stages of neuronal development, MTs are attached to the 

centrosome, located near the nucleus, through specialized structures called gamma-

tubulin ring complexes (γ-TuRCs), as mentioned before. This complex serves as a 

template for MT polymerization, binding to the minus-end of MTs and promoting their 

growth from the plus-end necessary for the motility and directionality of migrating 

neurons, but also their nucleation. However, in the course of neuron maturation the 

centrosome-dependent MT organization is lost, and so, differentiated neurons have non-

centrosomal MTs with the minus-ends distributed throughout the whole cell.38,82 

Consequently, in mature neurons the minus-ends of MTs can either bind to the γ-TuRC 

that is relocated to other non-centrosomal MTOC where MTs continue to be nucleated 

and stabilized, or they can attach laterally to a set of proteins known collectively as 

CAMSAPs - which includes the Drosophila protein Patronin - that stabilizes the minus-

ends of MTs in both dendrite and axon processes.38,51. It is known that both γ-TuRCs 

and CAMSAPs/Patronin can be considered capping proteins on the minus-ends of MTs, 

although the last ones appear to associate laterally with the minus-end51, where specific 

stabilizing factors associated with these proteins can be recruited to the growing minus-

ends and protect them against depolymerizing enzymes, similar to +TIPs at the plus-

ends of MTs.38  Accordingly, for CAMSAP-stabilized MTs to extend from their minus-

ends, either the γ-TURC needs to be removed from these ends, or new minus-ends must 

be created through MT breakage or severing. In neuronal cells, this implies that γ-TURC 

and CAMSAPs operate in separate, yet possibly sequential, phases to produce non-

centrosomal MT networks.82 

A recent study from Gao et al. (2024) showed that Patronin is essential for the proper 

development of synaptic boutons and NMJ morphology in Drosophila, likely through its 

role in stabilizing MTs at the presynaptic terminal. It also indicated that Patronin works 

synergistically with Shot, to control NMJ development. This suggests that both proteins 

play a collaborative role in stabilizing MTs at the synapse. Additionally, the knockdown 

of Patronin in Drosophila MNs resulted in significant defects in synaptic growth, 

specifically reducing the size of synaptic boutons at the NMJ. This reduction in bouton 

size was consistent across different stages of larval development, indicating Patronin's 

crucial role in maintaining NMJ growth.83 
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On the other hand, a study by Qu et al. (2019) uncovers the critical role of activity-

dependent MT nucleation at excitatory presynaptic boutons, particularly at en passant 

boutons, in regulating NT release in hippocampal neuronal cells. This study highlights 

that neuronal activity triggers de novo MT nucleation, driven by γ-tubulin and the augmin 

complex, which aligns MTs toward the distal axon tip. This MT nucleation enhances SV 

motility and bidirectional transport between boutons, crucial for efficient NT release and 

synaptic transmission. Furthermore, loss of MT nucleation due to γ-tubulin knockdown 

significantly impairs the movement of SVs between boutons, inhibiting their transport in 

both directions, leading to lower SVs at synapses. Consequently,  this disruption severely 

reduces the effectiveness of neurotransmission.84 

1.7. Justification and relevance of the topic   

Although defects in synaptic boutons are linked to neurological disorders, many 

fundamental aspects of bouton formation - such as how, when, and where they develop 

- remain largely unexplored. Fernandes et al. (2023) found that actin polymerization is 

not necessary for bouton outgrowth, however, actin is required for bouton stabilization. 

With this finding, new questions about the involvement of other cytoskeletal elements, 

such as MTs, in this process had raised. While the role of MTs in dendritic trees and 

axonal arbors has been well established13 and previous studies have shown that the MT 

cytoskeleton plays a critical role in regulating synaptic plasticity35,85, little is known about 

its specific contribution to bouton blebbing at the NMJ86. 

Therefore, this research focused on understanding the dynamic behavior of MTs 

during the formation and growth of new GB through confocal microscopy and live 

imaging. A multi-faceted approach using the Drosophila NMJ model was used to achieve 

this.  This NMJ is a stereotyped structure that is easily accessible through dissection but 

also by non-invasive imaging through the translucent larval cuticle. Moreover, it can be 

manipulated with sophisticated genetic mutagenesis, screening, expression, and editing 

strategies and is amenable to advanced biochemical, electrophysiological, 

ultrastructural, and light imaging techniques.23 Genetically encoded fluorescence 

markers for overexpressed proteins of interest, along with immunohistochemistry 

staining for others allow us to visualize their localization and intensity within the GB. 

Additionally, RNAi to knockdown the expression of various MTBPs was used to explore 

the impact of their reduction in GB formation and overall synaptic plasticity. By employing 

these techniques, we hope to better understand how MTs undergo rearrangements 

during bouton formation and how these changes impact synaptic plasticity.  
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Consequently, this topic has significant clinical implications since synaptic 

dysfunction is a hallmark of several neurological and neurodegenerative disorders.87 

Thus, a better understanding of the mechanisms that regulate the blebbing process could 

lead to the development of new therapeutic strategies that target MTs or MTBPs and the 

consequent improvement of synaptic function and plasticity in these disorders.  

1.7.1. Research question 

The research question for this study was the following: “What is the role of 

microtubules in the initiation and growth of synaptic boutons at the neuromuscular 

junction in Drosophila melanogaster?” 

1.7.2. Objectives  

The general and main goal of this study was to characterize microtubule behavior 

during neuronal growth in D. melanogaster. 

The specific aims are: 

1. Determine the best lines of Drosophila melanogaster to visualize the dynamic of 

microtubules;  

2. Assess microtubule localization and their dynamics in neurons before and after 

stimulation of synaptic activity;  

3. Characterize the role of MTs in bleb formation and growth through live and confocal 

imaging; 

4. Manipulate microtubule stability with polymerizers and depolymerizers of tubulin 

and assess the impact on neuronal growth and structural plasticity. 

1.8. Ethical and Legal Considerations  

National legislation regarding animal protection used for scientific purposes was 

created to ensure that the use of animals is always humane, careful, responsible, and 

justified.88 However, the use of D. melanogaster does not raise ethical problems, being 

that Directive 2010/63/EU of the European Parliament and of the Council of September 

22, 2010, since January 1, 2013, does not apply to insects, as they are not live non-

human vertebrate animals, nor live cephalopods. This legislation aims to improve the 

welfare of animals used for scientific purposes and promote the policy of the 3Rs 

(Replacement, Reduction, Refinement).88 Additionally, NOVA Medical School is licensed 
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for animal experimentation by the Direção-Geral de Alimentação e Veterinária, 

complying with European Directive 2010/63/EU and Decree-Law nº 113/2013. 

It is also worth noting that while D. melanogaster is not subject to the ethical 

restrictions outlined in Directive 2010/63/EU, we still adhered to the principles of the 3Rs 

by using the minimum number of larvae necessary for the scientific validity of our 

experiments.  
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2. Materials and Methods 

2.1. Drosophila culture and stocks 

To express RNAi or overexpress specific proteins in neurons, we crossed UAS-RNAi 

or UAS-GFP-tagged lines with nSyb-GAL4, a pan-neuronal driver. We used 5-10 virgin 

females and 3-5 males, anesthetized with CO2, and maintained the crosses at 25ºC. For 

RNAi experiments, flies were kept at 29ºC to enhance knockdown efficiency. To ensure 

that phenotypes were specifically due to RNAi knockdown and not effects from the nSyb-

GAL4 driver or genetic background, we used nSyb-GAL4 × w1118 as a control. 

TM6b or GFP expressing balancer chromosomes were used to facilitate genotyping 

of larva, therefore only first-generation non-tubby and/or fluorescent larvae were 

selected for dissection. 

For live imaging crosses between UAS-lines and nSyb-GAL4, CD4-Tom (where the 

CD4 present in the neuronal membrane is tagged with Tomato) were performed. 

A list of all fly stocks used in the experiments is attached in Table 3 on Supplementary 

information I. 

To assess the structural and functional aspects of GB formation at the NMJ in D.  

melanogaster, a systematic experimental workflow was employed (represented in Figure 

2.1). This workflow encompasses the dissection of third-instar larvae, the application of 

a stimulation protocol to induce GB formation, and high-resolution imaging to analyze 

the presence or absence of specific proteins within GBs. Additionally, quantitative 

measurements of GBs and NMJ areas were conducted in gene knockdown contexts to 

unravel the molecular mechanisms underlying synaptic plasticity. 

 

Figure 2.1 - Experimental workflow for GB analysis in D. melanogaster. The workflow includes 

third-instar larval dissection, stimulation protocols for GB induction, and imaging for protein localization 
and quantitative analyses. 
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2.2. Larval dissections and acute induction of activity-

dependent bouton formation  

The induction of new bouton formation is a critical step because it allows observation 

and analysis of the dynamics of MTs and their involvement in the structural changes 

associated with the formation, growth and stability of new boutons at the NMJ. In order 

to induce activity-dependent bouton formation, a well-stablished protocol described by 

Vasin, A. et al. (2014) was used to induce neuronal depolarization based on the 

administration of spaced High K+ and high calcium (Ca2+)30, which we call Short-Stim 

(SS). This protocol was performed on 3rd instar larvae. 

Third instar larvae are pinned down onto Sylgard-coated plates using insect pins and 

partially dissected in hemolymph-like (HL) 3.1 saline (in mM: 70 NaCl, 5 KCl, 0.1 CaCl2, 

4 MgCl2, 10 NaHCO3, 5 Trehalose, 115 Sucrose, 5 HEPES-NaOH, pH 7.2-7.4) using a 

procedure similar to Brent et al. (2009), a scenario equivalent to unstimulated, in which 

no or very few contractions were observed. Prior to being stimulated, one of the 

dissection pins was moved inward at approximately 60% of the original size of each larva 

to allow muscle contraction. The relaxed fillets were subjected to incubations in high-K+ 

(90 mM) and High Ca2+ (1.5 mM) HL3.1 adjusted for osmolarity changes with 2, 2, 2 

minutes pulses each separated by 10-minute incubation in regular HL3.1. In these 2-

minute incubations with high-K+ and Ca2+ solution, patterned contractions of the body 

wall muscles were observed. Lastly, larvae were incubated in HL3.1 with Ca2+ (0,5 mM) 

for 30 minutes to maximize bouton formation, during which the first 10 were to rest and 

the other 20 minutes were to perform the remaining dissection by removing the body fat 

and gut, while the CNS was kept intact until the beginning of the mounting process.  

For live imaging, larvae were glued to Sylgard-coated slides using topical veterinary 

tissue adhesive and stretched during dissection just enough to allow muscle contraction 

without excessive tension. Right after the stimulation protocol, larvae were imaged in 

HL3.1 saline for 30 minutes to 1.5 hours. 

2.3. Immunohistochemistry  

When the diverse experimental treatments were concluded, larval fillets were fixed in 

4% paraformaldehyde at room temperature (RT) for 20 minutes. The pins were then 

removed, and larvae were placed on an Eppendorf tube for immunohistochemistry with 
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Phosphate-buffered saline 1x + 0,3% Triton X-100 (PBST) to be extensively washed 3 

times for 45 minutes to 1 hour at RT with agitation, in order to permeabilize membranes.  

Primary antibody (Ab) incubation was performed overnight (ON) at 4ºC in the dark 

with agitation, in 5% Normal Goat Serum (NGS) to minimize unspecific Ab binding, in 

PBST. Subsequently, larvae were extensively washed using PBST, followed by 2 hours 

with secondary Ab and 5% NGS at RT with agitation in the dark. After extensive washing 

with PBST, larvae were transferred to 50% glycerol in PBS for 5 minutes and then 

mounted in DABCO medium on a microscope slide where the CNS, the head, and the 

tail were removed. Afterward, all larvae on the slide were covered with coverslips, sealed 

with nail polish, and stored at 4ºC in the dark until imaging. 

A list of all primary and secondary antibodies used in the experiments, along with 

their dilutions and sources, is provided in Table 1 and 2, respectively, in Supplementary 

Information I.  

2.4. MT stability manipulation   

In order to assess the impact of MT dynamics in GB development we used 1µM 

Vinblastine and 50µM Taxol dissolved in HL3.1 (0,1mM Ca2+; High K+/Ca2+; 0,5mM Ca2+) 

solutions, to destabilize and stabilize MT, respectively. Also, Dimethyl sulfoxide (DMSO) 

was also added to the working solutions of HL3.1 at the same dilution as the highest 

drug (50 µM), as control.  

For this experiment, firstly, larvae were dissected in HL3.1 without drugs, and then 

they were incubated in HL3.1 with the drug for 30 minutes and after that, stimulation 

protocol follows as previously described with the respective drugs in the HL3.1 working 

solutions. Controls were done in parallel, but using DMSO in HL3.1.  

2.5. NMJ imaging  

Confocal images were obtained on a laser scanning confocal microscope (LSM 710) 

with a 63x 1.3NA oil-emersion objective (Carl Zeiss) or inverted microscope (Observer) 

with the same objective. All images obtained were processed in imageJ/FIJI (National 

Institutes of Health) software. Live imaging experiences were performed with a spinning 

disk confocal microscope (Andor) with a 60X 1.3 NA oil-immersion objective (Carl Zeiss) 

equipped with a heating stage heated to 25ºC.  
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2.6. Data analysis  

Quantification of GB number was performed at NMJ 6/7, preferentially from 

abdominal segments A3-A5 were analyzed. In general, at least 12 (fixed) NMJs of each 

genotype were analyzed. Quantitative analyses were performed using maximum 

intensity projections from the Z-stacks on the image. GBs quantification was performed 

according to Gala, D. (2021). “The Big Confusing Book of Ghosts Boutons” unpublished.  

To analyze GB number in fixed samples, maximum intensity projections from Z-

stacks were used on image J. The macro used is summarized as follows: 

1) Image > Color > Channels tool > Composite 

      2) Image > Stacks > Z-project > Max intensity projection 

3) Image > Adjust > Brightness/Contrast 

4) Multi-point tool (for GB count)  

5) File > Save as > Tiff 

In order to assess immuno-localization of the proteins of interest within GBs, a semi-

quantitative scoring system was developed. The intensity scores were assigned 

manually by visual examination of the maximum intensity projections from Z-stacks and 

from the z-stacks itself. The scoring criteria are as follows: 

- Score 0: No detectable protein intensity. 

- Score 1: Low/Moderate intensity of protein expression. 

- Score 2: High intensity of protein expression. 

To analyze NMJs morphology and to identify possible phenotypes in RNAis, we 

measured NMJs’ areas in all RNAi and control lines. For this, the following steps were 

performed: 

1) Image > Stacks > Z Projection > Max Intensity 

2) Image > Color > Split Channels 

3) Image > Adjust > Brightness/Contrast 

4) Image > Adjust > Threshold 

5) Analyze > Measure (to measure NMJ area) 

6) File > Save as > Tiff 
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For analysis of live bouton formation, maximum intensity projections from z-stacks 

were used. The stacks were imported into image J using a plugin called Bio-formats for 

video mounting and editing, as follows:  

1) File > Import > Bio-formats  

2) Image > Stacks > Z-project > Max intensity (all slices and all time frames)  

3) Image > Stacks > Concatenate (if video was saved in separate files) 

4) Image > Color > Split channels (if more than one channel)  

5) Process > Enhance contrast > 0.1 to 0.3 % saturated pixels > normalize and 

process all slices  

6) Image > Color > Merge channels (if more than one channel)  

7) Stack > Animation > Animation options > Speed at 15 fps  

8) Rectangular selection > Image > Duplicate (to crop in a specific range of the stack)  

9) Videos were saved as AVI. 

2.6.1. Statistical analysis 

All statistical analysis and graph construction were performed in GraphPad Prism 

9.0.0. Data was tested for normality using the Shapiro-Wilk normality test. When data 

sets passed the normality test, statistical significance in two-way comparisons was 

determined by an unpaired Student’s t-test. When normality was not verified, a 

nonparametric unpaired t-test (Mann-Whitney) was used to compare two data sets. For 

MT stability manipulation experiments, in order to compare three datasets, the Krukal-

Wallis analysis was used when normality was not verified.  

In all figures, p-value is presented as: **** p<0.0001; *** p<0.001 ** p<0.01, * p<0.05, 

n.s. not significant. Statistical comparisons are with control unless noted. Sample size 

(n) is presented in the respective figure legend. 
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3. Results and Discussion 

Neuronal structure and plasticity rely heavily on MTs, which provide support to axons 

and dendrites while facilitating intracellular transport. This dynamic system allows 

neurons to modify synaptic connections and maintain effective communication.89 

Preliminary results from Fernandes et al. (2023) showed that: 1) GBs were enriched 

with EB1, 2) Futsch was present on the majority of GBs but not as typical Futsch loops 

which are present in mature synaptic boutons, and it rather looked as filamentous or 

splattered structures, and 3) α-tubulin aggregates were identified within GBs. These 

findings suggest that MTs present in GBs are not stable, but dynamic. Motivated by this 

discovery, we decided to test the role of these proteins in GB formation. We started by 

confirming the presence of EB1, Futsch, and α-tubulin in GBs in our experimental 

system. 

Given that EB1 is a key +TIP binding protein that regulates MT growth, we first sought 

to examine its localization in GBs to understand its potential influence on MT dynamics 

in the context of neuronal plasticity. For this, we conducted immunolocalization and 

fluorescence imaging of overexpressed EB1-GFP and live imaging of EB1. Consistent 

with the preliminary results described, our immunolocalization analysis confirmed that 

EB1 is present in 100% of GBs (see Figure 3.1, 3.2 and Figure 2 in Supplementary 

information III). Due to their significant role in MT regulation, EB1 is an ideal candidate 

to control MTs, and our results sustain the fact that this protein is a key player in GB 

outgrowth. Our results also point towards the idea that MTs might be polymerizing within 

GBs, which means that MTs are in a dynamic state at this stage of GB development. 

This encourages further exploration of how alterations in EB1 levels or activity might 

affect synaptic development and remodeling, so a future step will be to express the 

knockdown of this +TIP to understand if EB1 is crucial for GB development and - most 

importantly - formation. In parallel, we performed live imaging of this protein by 

expressing UAS-EB1-GFP and UAS-CD4-Tomato in neurons, using nSyb-Gal4. 

Unfortunately, in the movies acquired we were unable to observe GB formation events 

(Figure 1 in Supplementary information II). More movies need to be acquired in the 

future.  
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To improve our understanding of MT dynamics during new bouton formation, we 

examined Futsch, an important MTBP with specific MT interactions that may provide 

deeper insights into the structural organization of GBs. To address this, we performed 

overexpression and knockdown of Futsch, in neurons, using the neuronal driver nSyb-

Gal4 to express UAS-Futsch. In the overexpression immunofluorescence experiments, 

we found that most GB contained Futsch (around 74% as represented in Figure 3.3), 

predominantly at low intensity in the overexpression context, while a small number 

displayed high intensity and a few did not exhibited any Futsch within GBs (as shown in 

Figure 3 in Supplementary information III), however, we never observed Futsch loops. 

Typically, larger GBs expressed Futsch with higher intensity, whereas smaller GBs 

HRP EB1 DLG Merge 

Figure 3.2 - Localization of EB1 in ghost boutons at the Drosophila NMJ. EB1 (magenta) is present 

in ghost boutons (arrowheads). Presynaptic and postsynaptic membranes labeled with antibodies for 
Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), respectively. n = 22 NMJs, genotype nSyb-
Gal4;UAS-EB1-GFP 

 

Figure 3.1 – EB1 detection in GBs (after neuronal overexpression). EB1 was 

detectable in all 69 GBs (100%). n=22 NMJs, genotype nSyb-Gal4;UAS-EB1-GFP. 

 



   

 

33 
 

predominantly display either no detectable signal or low-level Futsch expression (see 

Figure 3.4). This suggests that the developmental stage of GBs is linked to their ability 

to have stabilized MTs, which is dependent on the presence and intensity of Futsch. 

 The reduction of Futsch levels through RNAi expression did not affect the NMJ area 

but resulted in a significant decrease in GB number as predicted (see Figure 3.5). This 

data suggests that Futsch is essential for the direct stabilization of GBs and may also 

indirectly facilitate their initiation. The presence of varying Futsch levels within GBs, 

including instances where it was undetectable, and the decrease in GB number upon 

reduced expression levels of this protein highlights the complexity of Futsch role and hint 

at Futsch being dynamic during bouton formation. In other words, this variability could 

reflect the dynamic regulation of MTs necessary for both the stabilization and 

development of GBs. Considering these results, an interesting idea for future research 

would be to determine whether Futsch knockdown also results in an increase in GB size, 

paralleling the enlargement seen in typical boutons at the NMJ, which would help us 

support our theory that Fustch is necessary in GB stabilization. 

 

  

Figure 3.3 - Futsch detection in GBs (after neuronal overexpression). Futsch was 

detectable in 83 from the 112 GBs accounted (74,1%), in green. 29 GBs had no detectable 
Futsch within (25,9%), in white. n=18 NMJs, genotype nSyb-Gal4;UAS-Futsch-GFP. 
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Figure 3.4 - Localization of Futsch in ghost boutons at the Drosophila NMJ. Futsch (magenta) 

is present in most ghost boutons (arrowheads). Presynaptic and postsynaptic membranes labeled with 
antibodies for Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), respectively. n = 18 
NMJs, genotype nSyb-Gal4;UAS-Futsch-GFP. 
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Having confirmed the involvement of MTBPs in GB outgrowth, we next aimed to 

investigate the core components of MTs, focusing specifically on their alpha- and beta-

tubulin subunits, starting with alpha-tubulin. This particular subunit was predominantly 

identified in a dispersed manner across the majority of GBs (around 68%) (see Figure 

3.6) in wild-type larvae, as represented in Figure 3.5. However, it is noteworthy that in a 

significant proportion of GBs we could not detect the presence of alpha-tubulin (around 

32%) (see Figure 3.7). However, through alpha-tubulin analysis, we can infer that MTs 

are not present in GBs as a stable structure but rather in a destabilized and 

depolymerized state. The observation of alpha-tubulin as punctate or scattered dots 

suggests that tubulin is present in GBs, but in a form that reflects MT instability rather 

than fully polymerized filaments. EB1, being a +TIP protein that associates with growing 

MT ends, further supports this hypothesis. Its consistent presence in all GBs indicates 

that MT extension and exploration are actively occurring, confirming the idea that MTs 

within GBs are highly dynamic and unstable, contributing to the rapid remodeling and 

outgrowth characteristic of these structures. 

 

 

 

B A 

Figure 3.5 – Quantification of GBs and NMJs area measurement after SS protocol. (A) Number 

of GBs. n=15 NMJs for nSyb; + and n=13 NMJs for nSyb; Futsch-IR. Statistical significance was determined 
using the nonparametric Mann-Whitney test; ****p<0,0001. (B) NMJ area. n=15 NMJs for nSyb;+ and n=13 
NMJs for nSyb; Futsch-IR. Statistical significance was determined using the Unpaired t-test; not significant 
(ns).  
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DLG (Post) 

HRP (Pre) 

Alpha-tubulin 

Figure 3.7 - Localization of alpha-tubulin in ghost boutons at the Drosophila NMJ. Alpha-tubulin 

(magenta) is present in most ghost boutons (arrowheads). Presynaptic and postsynaptic membranes 
labeled with antibodies for Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), 
respectively. n = 16 NMJs.  

Figure 3.6 - Quantification of alpha-tubulin intensity in GBs after SS protocol. 18 GBs had no 

detectable alpha-tubulin within, which represents about 32,1%. 38 GBs had low or moderate intensity of 
alpha-tubulin within, which represents about 67,9%. No GBs where found with high intensity of alpha tubulin. 
n= 16 NMJs 



   

 

37 
 

To further investigate the relationship between the tubulin subunits, we examined the 

presence of beta-tubulin to determine whether it exhibited similar distribution patterns as 

alpha-tubulin. This analysis aimed to elucidate whether these subunits existed as part of 

a stable MT complex or whether they functioned independently. Additionally, we sought 

to test whether EB1 was associated with beta-tubulin, which would manifest as with a 

consistent presence across all GBs. However, our findings indicated that beta-tubulin 

was rarely detected in GBs (around 78%) (see Figure 3.8 and 3.9) in wild-type larvae, 

and when present, it was predominantly localized in larger GBs, raising the possibility 

that the monoclonal Ab used may not effectively recognize all beta-tubulin subunits or 

have accessibility to the epitope that it recognizes, especially when they are 

depolymerized and possibly at low levels. Given the uncertainty regarding the detection 

of beta-tubulin isolated subunits, we cannot definitively conclude that EB1 associates 

with GBs independently of beta-tubulin; therefore, further investigation is needed to 

clarify this association.  
A 

DLG (Post) 

HRP (Pre) 

Beta-tubulin 

Figure 3.8 - Localization of beta-tubulin in ghost boutons at the Drosophila NMJ. Beta-tubulin 

(magenta) in most ghost boutons (arrowheads) is absent. Presynaptic and postsynaptic membranes 
labeled with antibodies for Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), respectively. 
n = 13 NMJs.  
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Tau was another MT stabilizer protein that we recognized as very promising due to 

its strong influence and importance in NMJ function, development, and plasticity, as well 

as its dynamic role with other MTBPs. Despite multiple attempts, Ab staining and the use 

of labelled Tau-lines did not yield successful results, as we were unable to visualize Tau 

in our preparation. However, the RNAi line targeting Tau was included in our screen for 

MTBPs.  The analysis revealed no significant differences in either the NMJ area nor the 

number of GBs in the RNAi Tau condition when compared to the control (see Figure 

3.10). As mentioned above, given its crucial roles in NMJ integrity and interactions with 

other MTBPs, we expected a decrease in the number of GB because EB1 localization 

depends on the expression levels and localization of Tau protein, but also because the 

reduction of Tau levels leads to a down-regulation between MTs and actin. Nevertheless, 

Tau provides a protective effect on MTs against severing proteins like Katanin-60 and 

Spastin. Thus, Tau depletion results in an increase in MT severing. Given these, we 

hypothesize that this double role of Tau may explain our results. Although a reduction in 

GB number would be anticipated due to Tau's role as a direct regulator of EB proteins in 

developing neuronal cells, the increase in MT severing could serve as a compensatory 

mechanism, which may account for the lack of significant change in GB count. In fact, 

Kuo et al. (2019) found that Spastin not only severs MTs but also promotes their regrowth 

through an ATP-independent mechanism leading to an increase in MT number and 

mass.69 The reduced MT stability caused by Tau’s knockdown led us to believe that the 

NMJs would be smaller. However, NMJ area resulting from diminished Tau levels might 

be counteracted by elevated severing activity, explaining the lack of difference compared 

Figure 3.9 - Quantification of beta-tubulin intensity in GBs after SS protocol. 31 GBs had no 

detectable beta-tubulin within, which represents about 77,5%. 9 GBs had low or moderate intensity of 
beta-tubulin within, which represents about 22,5%. No GBs where found with high intensity of alpha 
tubulin. n= 13 NMJs 
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with the control.  Another explanation is that the RNAi line used did not lead to high levels 

of reduction of Tau RNA. As such, additional RNAi lines against Tau should be tested. 

With this line of reasoning and the results indicating the presence of MTBPs within 

GBs, the following step was to investigate whether MT severing is necessary for GB 

formation, as it is required for proper neuronal formation and branching. To address this, 

we performed knockdown experiments targeting two major MT severing proteins, 

Spastin and Katanin-60. Contrary to what we expected, inhibition of both proteins did not 

impact the NMJ area (see Figure 3.11B and D). Since the reduction in MT severing would 

likely lead to an accumulation of stable MT networks, we expected that this stabilization 

would enhance synaptic integrity and facilitate growth, thereby contributing to the 

expansion of the NMJ area. Nevertheless, Spastin is involved in severing MTs, which 

allows for remodeling and turnover, but it also contributes to the stabilization and growth 

of MTs by reducing their tendency to shrink and facilitating recovery events.69 This 

balance may enable the NMJ area to remain stable despite its reduced expression. An 

alternative explanation for the observed results is that, despite the distinct mechanisms 

of action of these two severing proteins, both are involved in MT severing. Consequently, 

the knockdown of one protein may trigger compensatory mechanisms, whereby the 

remaining protein compensates for its loss, thereby maintaining the overall MT dynamics 

and preventing any significant changes in NMJ morphology. This lack of significant 

changes in the NMJ area can also be explained if compensatory mechanisms associated 

with other MTBPs, like Tau, that can maintain structural integrity despite the inhibition of 

B A 

Figure 3.10 – Quantification of GBs and NMJs area measurement after SS protocol. (A) Number 

of GBs. n=15 NMJs for nSyb; + and n=14 NMJs for nSyb; Tau-IR. Statistical significance was determined 
using the nonparametric Mann-Whitney test. (B) NMJ area. n=15 NMJs for nSyb;+ and n=14 NMJs for 
nSyb; Tau-IR. Statistical significance was determined using the Unpaired t-test; not significant (ns). 
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these specific proteins, as proposed previously. On the other hand, while the number of 

GBs in Spastin knockdown remained unaltered, the slight decrease observed in Katanin-

60 knockdown may be attributed to the distinct roles that these proteins play in MT 

dynamics (See Figure 3.11A and C). The decrease in GB numbers with Katanin-60 

knockdown likely results from impaired MT dynamics and reduced availability of MT ends 

needed for synaptic development and growth. Given Katanin’s normal function of 

promoting axonal MT depolymerization and severing90, the dynamic MT cytoskeletal 

environment required for synaptic plasticity is provided by their action. Although Tau 

serves as a protective factor against MT severing by P60-katanin (more so than Spastin), 

neurons exhibit higher levels of Katanin during periods of rapid axonal growth91, which 

Tau may not be able to protect MTs from. This suggests that Katanin plays a critical role 

in maintaining dynamic MTs and promoting synaptic development, including GB 

formation.  In contrast, Spastin knockdown does not have the same effect, potentially 

since Spastin functions in both severing and stabilizing MTs, which may allow for 

effective compensation, maintaining GB numbers despite its inhibition or through 

compensatory mechanisms (possibly associated with Tau) that can mitigate the loss of 

Spastin.  

Another interesting way to destabilize MTs is by manipulating their dynamics. To test 

how MT dynamics impact bouton growth we pharmacologically manipulated MTs during 

bouton formation using Vinblastine to induce MT depolymerization and Taxol as a MT 

B A D C 

Figure 3.11 – Quantification of GBs and NMJs area measurement after SS protocol. (A) Number of 

GBs. n=15 NMJs for nSyb; + and n=12 NMJs for nSyb; Spastin-IR. Statistical significance was determined using 
the Unpaired t-test; not significant (ns). (B) NMJ area. n=15 NMJs for nSyb; + and n=12 NMJs for nSyb; Spastin-
IR. Statistical significance was determined using the nonparametric Mann-Whitney test; not significant (ns). (C) 
Number of GBs. n=15 NMJs for nSyb; + and n=25 NMJs for nSyb; Katanin-60-IR. Statistical significance was 
determined using the nonparametric Mann-Whitney test; **p=0,0056. (D) NMJ area. n=15 NMJs for nSyb; + 
and n=25 NMJs for nSyb; Katanin-60-IR. Statistical significance was determined using the nonparametric Mann-
Whitney test; not significant (ns).  
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stabilizing drug and counted the number of GBs after stimulation in wild-type larvae. We 

observed that NMJs treated with Taxol exhibited a significant decrease in the number of 

GBs after stimulation, represented in Figure 3.12 and 3.13B. We also noticed that GBs 

with Taxol treatment, while fewer, they appear to be bigger and filled with Futsch, like 

represented in Figure 3.13C, although smaller GBs are also formed without any Futsch 

present inside. However, this distinctive phenotype needs to be quantified to assure that 

it is significantly different from controls. These findings may be attributed to the fact that 

for GBs to form, MTs need to be destabilized, and Taxol, as an MT stabilizer, likely 

inhibited the formation of GBs, leading to the observed decreased number.  

Interestingly, the effects of vinblastine treatment did not lead to an increase in GB 

number, despite its known role in destabilizing MTs, suggesting a more complex 

relationship between MT dynamics and GB formation. NMJs treated with vinblastine did 

not show a statistically significant difference in GB number (see Figure 3.12). Based on 

this data, we propose that these results may be due to the necessity of MT stabilization 

in the long-term for GB maturation. Inadequate MT stabilization may preclude GBs from 

reaching full maturation, thereby increasing the likelihood of retraction or degradation of 

these immature boutons. Consequently, the lack of an increase in GB numbers following 

vinblastine treatment could reflect insufficient stability needed for these structures to 

mature. Additionally, the lack of significant changes in GB numbers could be attributed 

to the low concentration of vinblastine used in our experiments, which may not have been 

sufficient to induce a noticeable effect on GB dynamics. Thus, both insufficient MT 

stability and concentration of vinblastine may contribute to the observed results. In the 

future, we should test additional concentrations of vinblastine. 

 

 

Figure 3.12 – Quantification of GBs after SS protocol and drug administration. Number of GBs. 

n=20 NMJs for DMSO, n=33 NMJs for Taxol, n=38 NMJs for Vinblastine; Statistical significance was 
determined using the Kruskal-Wallis; ***p=0,0001; not significant (ns) 
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Lastly, we decided to try to better understand cytoskeleton interactions, motivated by 

the findings of Fernandes et al. (2023) which highlighted the role of actin in GB 

stabilization and maturation. To investigate this further, we conducted 

immunolocalization and fluorescence imaging of overexpressed Shot-GFP and 

knockdown of Shot. Shot is an actin-MT linker and it is interesting to analyze how the 

two types of cytoskeleton are coordinated. The immunolocalization assay indicated that 

this protein is predominantly localized within GBs (around 90%) as represented in Figure 

3.15, exhibiting low intensity in most cases when we overexpressed Shot-GFP (see 

Figure 3.14). Notably, there were rare cases in which Shot was either absent or displayed 

in higher intensity (Figure 4 in Supplementary information III). These observations 

suggest that Shot may primarily interact with MTs and actin filaments to contribute to the 

structural integrity necessary for GB maturation. In light of our observations, we 

questioned what could happen if the expression of this protein, that makes this important 

Taxol  DMSO VinblastineC 

D B A 

Figure 3.13 – MT stability manipulation through drug administration at the Drosophila NMJs. (A) 

NMJ with drug positive control (DMSO). n=20 NMJs (B) NMJ with Taxol administration. n=33 NMJs(C) 
Amplification of GB treated with Taxol filled with Futsch (D) NMJ with Vinblastine administration. n=38 
NMJs. Futsch (magenta) in ghost boutons (arrowheads). Presynaptic and postsynaptic membranes labeled 
with antibodies for Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), respectively.  
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connection between two major cytoskeleton components, was knockdown. For this, we 

expressed Shot RNAi in neurons using nSyb-Gal4. Our results showed a significant 

reduction in GB number, and no alteration in NMJ area when compared with the control 

values (see Figure 3.16A and B), although we did identify a distinctive NMJ phenotype 

characterized by excessive branching and elongated branches, however this phenotype 

still needs to be quantified to assure that it is significantly different from the controls. 

Given our hypothesis that Shot functions as a crosslinker between MTs and actin, 

reduced levels of this protein may result in impaired recruitment or crosslinking with actin, 

ultimately compromising GB stability. 

 

DLG (Post) 

HRP (Pre) 

Shot 

Figure 3.14 - Localization of Shot in ghost boutons at the Drosophila NMJ after SS protocol.  
Shot (red) in ghost boutons (arrowheads). Presynaptic and postsynaptic membranes labeled with 
antibodies for Horseradish peroxidase (HRP-white) and Discs-large (Dlg-green), respectively. n=13 NMJs. 
On the four smaller boxes we can see with greater amplification the GBs and the presence of Shot in a 
scattered pattern. n=13 NMJs, genotype nSyb-Gal4;UAS-Shot-GFP  
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Figure 3.15 - Shot detection in GBs (after neuronal overexpression). Shot was 

detectable in 70 from the 79 GBs accounted (88,6%), in light red. 9 GBs had no detectable Shot 
within (11,4%), in white. n=13 NMJs, genotype nSyb-Gal4;UAS-Shot-GFP 

 

A 

Figure 3.16 - Quantification of GBs and NMJs area measurement after SS protocol. 

(A) Number of GBs. n=41 NMJs for nSyb; + and n=35 NMJs for nSyb; Shot-IR. Statistical 
significance was determined using the nonparametric Mann-Whitney test; ****p<0,0001. (B) 
NMJ area. n=41 for nSyb;+ and n=35 NMJs for nSyb; Shot-IR. Statistical significance was 
determined using the Unpaired t-test; not significant (ns).  
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4. Final Considerations 

4.1. Conclusions 

Studying how the components of the cytoskeleton are regulated is essential to the 

understanding of the cellular and molecular mechanisms underlying synaptic 

development. The integrity and morphology of neurons depends on their cytoskeleton. 

Although there are already studies at the D. melanogaster NMJ on the role of actin in the 

formation and outgrowth of new GBs (considered precursors of mature synaptic 

boutons), little is known regarding the role of MTs in this process. Here, using 

overexpression and knockdown of MTBPs in Drosophila larval NMJ, visualization of the 

basic subunits of MTs – alpha and beta-tubulin –, and MT 

polymerization/depolymerization through administration of specific drugs we showed 

how MT dynamics and MTBPs contribute to synaptic plasticity and neuronal growth. 

Regarding tubulin subunits, we discovered that alpha-tubulin was present in most 

GBs. Beta-tubulin however was only observed in bigger GBs. We hypothesize that this 

can be due to the inaccessibility of this subunit to be recognized with the Ab used, or due 

to some detection problem since alpha- and beta-tubulin are normally present in 

dimmers. In the future, this subunit must be screened with another Ab, Drosophila line 

or even overexpressed to better assess its presence. 

Our analysis identified key MTBPs, notably EB1, Futsch, and Shot, as significant 

participants in the blebbing process. EB1 was the only MTBP screened that was present 

in all GBs, which reflects its role in driving the dynamic and exploratory MT behavior that 

is critical for synaptic outgrowth. As a +TIP protein, it facilitates MT polymerization, which 

we theorized may be happening during GB development. EB1’s ability to link MT 

dynamics with synaptic signaling and its function as a scaffold for other regulatory 

proteins make it uniquely essential in the early, plastic stages of GB formation, explaining 

why it is found in every GB. Knockdown of EB1 should be performed to confirm this 

hypothesis. Futsch was necessary for bouton stabilization and growth, indicating that 

they regulate the behavior of MTs during synaptic remodeling. Both Futsch and Shot 

were found in the majority of GBs and knockdowns of these proteins resulted in a 

decrease in GB formation. Given that both proteins are considered MT stabilizing 

proteins, it suggests that MT stability plays a crucial role in the initiation and/or 

maintenance of GB formation, although for different reasons. Futsch is primarily involved 

in providing direct MT stability, and when expressed at low levels, GBs are more prone 
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to failure in stabilizing and maturing. The inability to maintain stable MTs could disrupt 

the structural integrity required for GB maturation. From a GB initiation perspective, 

reduced levels of Futsch may act as a molecular signal indicating that neuronal 

development and synaptic expansion are not a signaled, potentially halting the formation 

of new synaptic sites. Shot’s role as a linker between MTs and actin filaments is crucial, 

particularly during the stabilization and maturation phases of GBs, when actin becomes 

essential. A reduction in Shot expression likely destabilizes MTs, preventing them from 

anchoring properly to the actin cytoskeleton. Without this connection, GBs are unable to 

stabilize, failing to mature into fully developed synapses. Colocalization between actin 

filaments and Shot should be performed to test this idea. 

The results presented in this dissertation show that MT stability is essential for the 

formation and stabilization of new GBs. Taxol-induced stabilization of MTs prevented the 

formation of GBs, confirming that MT destabilization is a necessary step for bouton 

initiation. Conversely, destabilization with Vinblastine did not result in the possibly 

expected increase in GB numbers, suggesting that MT stability, while not required for 

GB initiation, may be crucial for their maturation. This highlights the fine balance between 

polymerization and depolymerization in GB formation. 

In addition, we identified a differential role of MT-severing proteins. Katanin 

knockdown reduced GB numbers, possibly by reducing MT polymerization frequency, 

suggesting that MT severing is important for the blebbing process at the NMJ. 

Conversely, the lack of significant impact from Spastin knockdown points to the existence 

of compensatory mechanisms possibly Tau-associated, or to a reduced efficiency of KD 

with the RNAi line used. 

In addition to the roles of MT-severing proteins in NMJ dynamics, the potential 

involvement of MT nucleation - particularly through kinetochores and centrosomes -

warrants consideration due to its possible impact on GB formation. Both kinetochores 

and centrosomes are essential for organizing MTs during cell division, but components 

of these structures also influence MT dynamics in post-mitotic neurons.92,93 Investigating 

these dynamics could offer valuable insights into their potential role in processes such 

as GB formation and synaptic function. 

Preliminary results from the lab showed that MT nucleation might have a role in the 

blebbing process. MIS-12 protein – a member of the kinetochore complex – may play a 

role in the GB formation process, as its knockdown results in a decrease in GB numbers 

(Figure 5 in Supplementary information III). Furthermore, centrosomin (CNN), a crucial 
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centrosomal protein responsible for recruiting γ-Tubulin during MT nucleation, emerges 

as a significant player in MT dynamics within post-mitotic neurons. CNN has been found 

to contribute to dendritic arborization and is involved in localizing MT nucleation through 

an anchoring mechanism similar to that observed in dividing cells.94 Preliminary findings 

from the lab suggest that CNN knockdown results in a reduction of GB numbers as well 

(Figure 6 in Supplementary information III). So, in the future it might be interesting to 

understand if MT nucleation is a crucial factor for GB formation, by conducting 

experiments directed to γ-tubulin. 

Based on our findings, we propose the following model for MT dynamics in GB 

formation at the NMJ: 

Initially, EB1 receives a molecular signal to localize at the site where a GB is about 

to form. Katanin then severs MTs at the NMJ, breaking them into smaller fragments and 

depolymerizing these severed MT ends. Succeeding, EB1 invades this blebbing site, 

promoting MT polymerization which might start in the de novo MT nucleation site. This 

polymerization activity likely occurs near the GB, starting at its base. During this 

polymerization process, alpha- and beta-tubulin subunits are available and scattered 

within the GB, due to Katanin depolymerization action, to incorporate into the 

polymerizing nucleated MTs. As the MTs extend, other MTBPs, such as Shot and 

Futsch, are recruited to provide additional stability. In the stabilization phase, actin 

filaments are also present and likely play a role in maintaining the structure through 

interactions between MTs – Shot – actin filaments.  At this stage, Futsch helps to stabilize 

the polymerized MTs. Once stabilization is achieved, the maturation phase begins. Here, 

MTs are fully stabilized, with Shot mediating the connection between actin filaments and 

the stable MTs within the GB and Futsch contributing further to this stabilization by 

forming loops, completing the process of GB maturation. To complement this model, we 

have created a visual scheme that illustrates these dynamic processes, providing a clear 

and comprehensive representation of the stages described (Figure 4.1). 

 Figure 4.1 - Schematic representation of the proposed hypothesis for GB formation and 
maturation. The process involves four stages: (1) Initiation, where Katanin severs MTs, promoting local 

MT dynamics along with EB1; (2) Expansion, characterized by polymerization and recruitment of proteins 
such as Futsch and Shot; (3) Stabilization, involving actin remodeling and MT stabilization; and (4) 
Maturation, marked by the crosslinking between MTs and actin filaments to form a fully developed GB. 
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Overall, this research contributes to the broader understanding of how MT dynamics 

orchestrate synaptic plasticity, with both MT stability and severing playing key roles in 

synaptic bouton formation and stabilization. These findings provide a foundation for 

further exploration of MT-related mechanisms in synaptic function and dysfunction, 

potentially contributing to the development of therapeutic strategies for 

neurodegenerative diseases characterized by synaptic plasticity deficits, such as AD. 

4.2. Additional research suggestions 

To comprehensively characterize the role of MTs in GB formation and outgrowth, 

several avenues of research can be pursued. First, live imaging is a powerful tool that 

would enable us to analyze in real-time how MTs contribute to both the structural integrity 

and functional development of GBs. By labelling different MAPs, this approach would 

also allow us to assess the involvement of EB1 in the initiation of GB formation and to 

determine whether severing proteins actively contribute to this process.  To further 

confirm the specific role of EB1 in GB formation, it would be valuable to reduce its 

expression levels and observe the resultant effects on MT dynamics and bouton 

formation, and because this +TIP can recruit other MTBPs, it will be interesting to see if 

lower levels of this protein have any influence on other MTBPs, like Futsch.  This 

experiment could provide direct evidence of EB1’s contribution to the processes 

associated with GB development. 

To explore our hypothesis that compensatory mechanisms may occur, a 

simultaneous knockdown of Spastin and Tau should be conducted. Since both proteins 

have distinct but potentially complementary roles in regulating MT dynamics this 

approach will help determine whether a compensatory relationship exists between them. 

Observing the consequences of dual knockdown on GB formation and stability will offer 

insights into their functional interdependence. 

Additionally, a straightforward hypothesis to investigate is the correlation between 

Shot as a linker to actin. Understanding how Shot facilitates the stabilization and 

maturation of GBs through its interactions with the actin cytoskeleton could provide 

valuable information about the interplay between MTs and actin in synaptic development. 

As mentioned before, a recent paper revealed that Shot and Patronin work together to 

regulate NMJ development, suggesting that both proteins collaborate to stabilize MTs at 

the synapse. Patronin knockdown in Drosophila MNs led to significant synaptic growth 

defects, notably reducing bouton size at the NMJ across different larval stages, 
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underscoring its key role in NMJ maintenance.83 Thus, Patronin might also be involved 

in the blebbing process, even if indirectly, by manipulating MT polarity and stability.  

By pursuing these research objectives, we can gain a deeper understanding of the 

complex mechanisms that govern GB formation and the critical roles of MTBPs in this 

process, along with MT severing and nucleation processes in plasticity mechanisms. 

In conclusion, although many questions remain to be answered, this study highlights 

how the precise orchestration of MT dynamics and MTBPs are crucial to the blebbing 

process, marking a key step forward in understanding the molecular basis of neural 

plasticity. 

  



   

 

50 
 

 

 

 

 

 

 

 

 

 

 

 

Page intentionally left blank 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



   

 

51 
 

5. References 

1.  Luo L. Principles of Neurobiology. Garland Science, Taylor & Francis Group, LLC; 

2016.  

2.  Brain Basics: The Life and Death of a Neuron | National Institute of Neurological 

Disorders and Stroke [Internet]. [cited 2024 Apr 27]. Available from: 

https://www.ninds.nih.gov/health-information/public-education/brain-basics/brain-

basics-life-and-death-neuron 

3.  Dharani K. Physiology of the Neuron. In: The Biology of Thought. Academic Press; 

2015. p. 31–52.  

4.  Purves D, Augustine GJ, Fitzpatrick D, Katz LC, LaMantia AS, McNamara JO, et 

al. The Initial Formation of the Nervous System: Gastrulation and Neurulation. In: 

Neuroscience. 2nd ed. Sinauer Associates; 2001.  

5.  Lambert de Rouvroit C, Goffinet AM. Neuronal migration. Mech Dev. 2001 Jul 

1;105(1–2):47–56.  

6.  Chen Y, Geng Y. Synapse engineering: A new level of brain modulation. Brain 

Res Bull. 2017 Mar;129:23–9.  

7.  Chen M, Zheng B. Axon Plasticity in the Mammalian Central Nervous System after 

Injury. Trends Neurosci. 2014 Oct 1;37(10):583–93.  

8.  Lüscher C, Malenka RC. NMDA Receptor-Dependent Long-Term Potentiation 

and Long-Term Depression (LTP/LTD). Cold Spring Harb Perspect Biol. 2012 

Jun;4(6):1–15.  

9.  Dorszewska J, Kozubski W, Waleszczyk W, Zabel M, Ong K. Neuroplasticity in 

the Pathology of Neurodegenerative Diseases. Neural Plast. 2020 May 27;2020.  

10.  Sheng M, Sabatini BL, Südhof TC. Synapses and Alzheimer’s Disease. Cold 

Spring Harb Perspect Biol. 2012 May 1;4(5):10.  

11.  Hammond C, Esclapez M. The chemical synapses. In: Cellular and Molecular 

Neurophysiology: Fourth Edition. Academic Press; 2015. p. 121–44.  

12.  Smith DL, Plowman SA. Understanding Muscle Contraction. In: Sports-Specific 

Rehabilitation. Churchill Livingstone; 2007. p. 15–38.  

13.  Liu W, Chakkalakal J V. The Composition, Development, and Regeneration of 

Neuromuscular Junctions. In: Current Topics in Developmental Biology. Academic 



   

 

52 
 

Press; 2018. p. 99–124.  

14.  Rodríguez Cruz PM, Cossins J, Beeson D, Vincent A. The Neuromuscular 

Junction in Health and Disease: Molecular Mechanisms Governing Synaptic 

Formation and Homeostasis. Front Mol Neurosci. 2020 Dec 3;13:610964.  

15.  Hall ZW, Sanes JR. Synaptic structure and development: The neuromuscular 

junction. Cell. 1993 Jan;72(1001):99–121.  

16.  Van Vactor D, Sigrist SJ. Presynaptic morphogenesis, active zone organization 

and structural plasticity in Drosophila. Curr Opin Neurobiol. 2017 Apr 1;43:119–

29.  

17.  Bai Y, Suzuki T. Activity-Dependent Synaptic Plasticity in Drosophila 

melanogaster. Front Physiol. 2020 Feb 25;11:161.  

18.  Frank CA, Wang X, Collins CA, Rodal AA, Yuan Q, Verstreken P, et al. New 

Approaches for Studying Synaptic Development, Function, and Plasticity Using 

Drosophila as a Model System. J Neurosci. 2013 Nov 6;33(45):17568.  

19.  Hales KG, Korey CA, Larracuente AM, Roberts DM. Genetics on the Fly: A Primer 

on the Drosophila Model System. Genetics. 2015 Nov;201(3):815–42.  

20.  Tolwinski NS. Introduction: Drosophila—A Model System for Developmental 

Biology. J Dev Biol. 2017 Sep;5(3).  

21.  Banerjee S, Benji S, Liberow S, Steinhauer J. Using Drosophila melanogaster To 

Discover Human Disease Genes: An Educational Primer for Use with 

“Amyotrophic Lateral Sclerosis Modifiers in Drosophila Reveal the Phospholipase 

D Pathway as a Potential Therapeutic Target.” Genetics. 2020 Sep 9;216(3):641.  

22.  Vasin A, Sabeva N, Torres C, Phan S, Bushong EA, Ellisman MH, et al. Two 

Pathways for the Activity-Dependent Growth and Differentiation of Synaptic 

Boutons in Drosophila. eNeuro. 2019 Jul 1;6(4):60–79.  

23.  Chou VT, Johnson SA, Van Vactor D. Synapse development and maturation at 

the drosophila neuromuscular junction. Neural Dev. 2020 Aug 2;15(11):1–17.  

24.  Menon KP, Carrillo RA, Zinn K. Development and plasticity of the Drosophila larval 

neuromuscular junction. Wiley Interdiscip Rev Dev Biol. 2013 Feb 5;2(5):647–70.  

25.  Ruiz-Cañada C, Budnik V. Introduction on The Use of The Drosophila 

Embryonic/Larval Neuromuscular Junction as A Model System to Study Synapse 



   

 

53 
 

Development and Function, and A Brief Summary of Pathfinding and Target 

Recognition. Int Rev Neurobiol. 2006;75:1–31.  

26.  Ho Koh Y, Sian Gramates L, Budnik V. Drosophila Larval Neuromuscular 

Junction: Molecular Components and Mechanisms Underlying Synaptic Plasticity. 

Microsc Res Tech. 2000;49:14–25.  

27.  Jeibmann A, Paulus W. Drosophila melanogaster as a Model Organism of Brain 

Diseases. Int J Mol Sci. 2009 Feb;10(2):440.  

28.  Zhang YQ, Bailey AM, Matthies HJG, Renden RB, Smith MA, Speese SD, et al. 

Drosophila fragile x-related gene regulates the MAP1B homolog Futsch to control 

synaptic structure and function. Cell. 2001 Nov 30;107(5):591–603.  

29.  Ataman B, Ashley J, Gorczyca M, Ramachandran P, Fouquet W, Sigrist SJ, et al. 

Rapid Activity-Dependent Modifications in Synaptic Structure and Function 

Require Bidirectional Wnt Signaling. Neuron. 2008 Mar;57(5):718.  

30.  Vasin A, Zueva L, Torrez C, Volfson D, Troy Littleton J, Bykhovskaia M. Synapsin 

regulates activity-dependent outgrowth of synaptic boutons at the Drosophila 

neuromuscular junction. J Neurosci. 2014 Aug 6;34(32):10554–63.  

31.  Fuentes-Medel Y, Ashley J, Barria R, Maloney R, Freeman M, Budnik V. 

Integration of a Retrograde Signal during Synapse Formation by Glia-Secreted 

TGF-β Ligand. Curr Biol. 2012 Oct 9;22(19):1831–8.  

32.  Fernandes AR, Martins JP, Gomes ER, Mendes CS, Teodoro RO. Drosophila 

motor neuron boutons remodel through membrane blebbing coupled with muscle 

contraction. Nat Commun 2023 141. 2023 Jun 8;14(1):1–20.  

33.  Schick J, Raz E. Blebs—Formation, Regulation, Positioning, and Role in 

Amoeboid Cell Migration. Front Cell Dev Biol. 2022 Jul 15;10:1470.  

34.  Cooper GM. Microtubules. In: The Cell: A Molecular Approach. 2nd editio. Sinauer 

Associates; 2000.  

35.  Waites C, Qu X, Bartolini F. The Synaptic Life of Microtubules. Curr Opin 

Neurobiol. 2021 Aug 1;69:123.  

36.  Mitchison T, Kirschner M. Dynamic instability of microtubule growth. Nat 1984 

3125991. 1984;312(5991):237–42.  

37.  Conde C, Cáceres A. Microtubule assembly, organization and dynamics in axons 



   

 

54 
 

and dendrites. Nat Rev - Neurosci. 2009 May;10(5):319–32.  

38.  Akhmanova A, Hoogenraad CC. Microtubule minus-end-targeting proteins. Curr 

Biol. 2015 Feb 16;25(4):R162–71.  

39.  Baas PW, Deitch JS, Black MM, Banker GA. Polarity orientation of microtubules 

in hippocampal neurons: uniformity in the axon and nonuniformity in the dendrite. 

Proc Natl Acad Sci U S A. 1988 Nov;85(21):8339.  

40.  Thyagarajan P, Feng C, Lee D, Shorey M, Rolls MM. Microtubule polarity is 

instructive for many aspects of neuronal polarity. Dev Biol. 2022 Jun;486:56–70.  

41.  Alberts B, Johnson A, Lewis J, Morgan D, Raff M, Roberts K, et al. The 

Cytoskeleton. In: Wilson J, Hunt T, editors. Molecular Biology of the Cell. 6th 

Edition. New York: Garland Science, Taylor & Francis Group; 2017. p. 889–962.  

42.  Dent EW, Baas PW. Microtubules in neurons as information carriers. J 

Neurochem. 2014;129(2):239.  

43.  Dent EW. Dynamic microtubules at the synapse. Curr Opin Neurobiol. 2020 

Aug;63:14.  

44.  Ma L, Tymanskyj SR. Axon growth and branching. Cell Migr Form Axons 

Dendrites Compr Dev Neurosci. 2020 Jan 1;57–85.  

45.  Mortimer D, Goodhill GJ. Axonal Pathfinding. Encycl Neurosci. 2009;1133–8.  

46.  Kahn OI, Baas PW. Microtubules and Growth Cones: Motors Drive the Turn. 

Trends Neurosci. 2016 May 24;39(7):440.  

47.  Rolls MM, Thyagarajan P, Feng C. Microtubule dynamics in healthy and injured 

neurons. Dev Neurobiol. 2020 Apr 15;81(3):321–32.  

48.  Cappelletti G, Calogero AM, Rolando C. Microtubule acetylation: A reading key to 

neural physiology and degeneration. Neurosci Lett. 2021 Jun 11;755.  

49.  Carlson K, Ocean AJ. Peripheral Neuropathy with Microtubule-Targeting Agents: 

Occurrence and Management Approach. Clin Breast Cancer. 2011 Apr 

1;11(2):73–81.  

50.  Witte H, Neukirchen D, Bradke F. Microtubule stabilization specifies initial 

neuronal polarization. J Cell Biol. 2008 Feb 11;180(3):632.  

51.  Goodson H V., Jonasson EM. Microtubules and Microtubule-Associated Proteins. 

Cold Spring Harb Perspect Biol. 2018 Jun 1;10(6).  



   

 

55 
 

52.  Pacheco A, Gallo G. Actin Filament-Microtubule Interactions in Axon Initiation and 

Branching. Brain Res Bull. 2016 Sep;126(Pt 3):310.  

53.  Halpain S, Dehmelt L. The MAP1 family of microtubule-associated proteins. 

Genome Biol. 2006 Jun 30;7(6):1–7.  

54.  Dehmelt L, Halpain S. The MAP2/Tau family of microtubule-associated proteins. 

Genome Biol. 2005;6(1):204.  

55.  Bouquet C, Soares S, Von Boxberg Y, Ravaille-Veron M, Propst F, Nothias F. 

Microtubule-Associated Protein 1B Controls Directionality of Growth Cone 

Migration and Axonal Branching in Regeneration of Adult Dorsal Root Ganglia 

Neurons. J Neurosci. 2004 Aug 8;24(32):7204.  

56.  Barnat M, Benassy MN, Vincensini L, Soares S, Fassier C, Propst F, et al. The 

GSK3–MAP1B pathway controls neurite branching and microtubule dynamics. 

Mol Cell Neurosci. 2016 Apr 1;72:9–21.  

57.  Hummel T, Krukkert K, Roos J, Davis G, Klämbt C. Drosophila Futsch/22C10 is a 

MAP1B-like protein required for dendritic and axonal development. Neuron. 2000 

May;26(2):357–70.  

58.  Roos J, Hummel T, Ng N, Klämbt C, Davis GW. Drosophila Futsch Regulates 

Synaptic Microtubule Organization and Is Necessary for Synaptic Growth. 

Neuron. 2000 May 1;26(2):371–82.  

59.  Leveille E, Ross OA, Gan-Or Z. Tau and MAPT genetics in tauopathies and 

synucleinopathies. Parkinsonism Relat Disord. 2021 Sep 1;90:142–54.  

60.  Strang KH, Golde TE, Giasson BI. MAPT mutations, tauopathy, and mechanisms 

of neurodegeneration. Lab Invest. 2019 Jul;99(7):928.  

61.  Arendt T, Stieler JT, Holzer M. Tau and tauopathies. Brain Res Bull. 2016 

Sep;126:238–92.  

62.  Medeiros R, Baglietto-Vargas D, Laferla FM. The Role of Tau in Alzheimer’s 

Disease and Related Disorders. CNS Neurosci Ther. 2011 Oct;17(5):524.  

63.  Cassimeris L. Microtubule Associated Proteins in Neurons. Encycl Neurosci. 2009 

Jan 1;865–70.  

64.  Yu W, Qiang L, Solowska JM, Karabay A, Korulu S, Baas PW. The Microtubule-

severing Proteins Spastin and Katanin Participate Differently in the Formation of 



   

 

56 
 

Axonal Branches. Mol Biol Cell. 2008 Apr;19(4):1485–98.  

65.  Yu W, Solowska JM, Qiang L, Karabay A, Baird D, Baas PW. Regulation of 

Microtubule Severing by Katanin Subunits during Neuronal Development. J 

Neurosci. 2005 Jun 8;25(23):5573–83.  

66.  Lombino FL, Schwarz JR, Pechmann Y, Schweizer M, Jark R, Stange O, et al. 

Functional Inhibition of Katanin Affects Synaptic Plasticity. J Neurosci. 2024 Mar 

27;44(13).  

67.  Sherwood NT, Sun Q, Xue M, Zhang B, Zinn K. Drosophila spastin regulates 

synaptic microtubule networks and is required for normal motor function. PLoS 

Biol. 2004 Dec;2(12).  

68.  Ozdowski EF, Gayle S, Bao H, Zhang B, Sherwood NT. Loss of Drosophila 

melanogaster p21-activated kinase 3 Suppresses Defects in Synapse Structure 

and Function Caused by spastin Mutations. Genetics. 2011 Sep;189(1):135.  

69.  Kuo YW, Trottier O, Mahamdeh M, Howard J. Spastin is a dual-function enzyme 

that severs microtubules and promotes their regrowth to increase the number and 

mass of microtubules. Proc Natl Acad Sci U S A. 2019 Mar 5;116(12):5533–41.  

70.  Trotta N, Orso G, Rossetto MG, Daga A, Broadie K. The hereditary spastic 

paraplegia gene, spastin, regulates microtubule stability to modulate synaptic 

structure and function. Curr Biol. 2004 Jul 13;14(13):1135–47.  

71.  Zempel H, Mandelkow EM. Tau missorting and spastin-induced microtubule 

disruption in neurodegeneration: Alzheimer Disease and Hereditary Spastic 

Paraplegia. Mol Neurodegener. 2015 Dec 21;10(1):1–12.  

72.  van de Willige D, Hoogenraad CC, Akhmanova A, Hoogenraad choogenraad CC, 

Akhmanova aakhmanova A. Microtubule plus-end tracking proteins in neuronal 

development. Cell Mol Life Sci 2016 7310. 2016 Mar 11;73(10):2053–77.  

73.  Maurer SP, Fourniol FJ, Bohner G, Moores CA, Surrey T. EBs Recognize a 

Nucleotide-Dependent Structural Cap at Growing Microtubule Ends. Cell. 2012 

Apr 13;149(2–2):382.  

74.  Tortosa E, Galjart N, Avila J, Sayas CL. MAP1B regulates microtubule dynamics 

by sequestering EB1/3 in the cytosol of developing neuronal cells. EMBO J. 2013 

May 2;32(9):1306.  

75.  Sayas CL, Tortosa E, Bollati F, Ramírez-Ríos S, Arnal I, Avila J. Tau regulates 



   

 

57 
 

the localization and function of End-binding proteins 1 and 3 in developing 

neuronal cells. J Neurochem. 2015 Jun;133(5):653–67.  

76.  Voelzmann A, Hahn I, Pearce SP, Sánchez-Soriano N, Prokop A. A conceptual 

view at microtubule plus end dynamics in neuronal axons. bioRxiv. 2016 Jan 

1;62711.  

77.  Suozzi KC, Wu X, Fuchs E. Spectraplakins: Master orchestrators of cytoskeletal 

dynamics. J Cell Biol. 2012 May 14;197(4):475.  

78.  Zhang J, Yue J, Wu X. Spectraplakin family proteins – cytoskeletal crosslinkers 

with versatile roles. J Cell Sci. 2017 Aug 1;130(15):2457.  

79.  Elie A, Prezel E, Guérin C, Denarier E, Ramirez-Rios S, Serre L, et al. Tau co-

organizes dynamic microtubule and actin networks. Sci Reports 2015 51. 2015 

May 5;5(1):1–10.  

80.  Biswas S, Kalil K. The Microtubule-Associated Protein Tau Mediates the 

Organization of Microtubules and Their Dynamic Exploration of Actin-Rich 

Lamellipodia and Filopodia of Cortical Growth Cones. J Neurosci. 2018 Jan 

10;38(2):307.  

81.  Rodriguez OC, Schaefer AW, Mandato CA, Forscher P, Bement WM, Waterman-

Storer CM. Conserved microtubule–actin interactions in cell movement and 

morphogenesis. Nat Cell Biol 2003 57. 2003 Jul 1;5(7):599–609.  

82.  Akhmanova A, Steinmetz MO. Control of microtubule organization and dynamics: 

two ends in the limelight. Nat Rev Mol Cell Biol 2015 1612. 2015 Nov 

12;16(12):711–26.  

83.  Gao Z, Huang E, Wang W, Xu L, Xu W, Zheng T, et al. Patronin regulates 

presynaptic microtubule organization and neuromuscular junction development in 

Drosophila. iScience. 2024 Feb 16;27(2).  

84.  Qu X, Kumar A, Blockus H, Waites C, Bartolini F. Activity-Dependent Nucleation 

of Dynamic Microtubules at Presynaptic Boutons Controls Neurotransmission. 

Curr Biol. 2019 Dec 16;29(24):4231-4240.e5.  

85.  Long JB, Van Vactor D. Embryonic and larval neural connectivity: progressive 

changes in synapse form and function at the neuromuscular junction mediated by 

cytoskeletal regulation. Wiley Interdiscip Rev Dev Biol. 2013;2(6):747–65.  

86.  Sugiyama T, Pramanik MK, Yumura S. Microtubule-Mediated Inositol Lipid 



   

 

58 
 

Signaling Plays Critical Roles in Regulation of Blebbing. PLoS One. 2015 Aug 

28;10(8).  

87.  Lepeta K, Lourenco M V., Schweitzer BC, Martino Adami P V., Banerjee P, 

Catuara-Solarz S, et al. Synaptopathies: synaptic dysfunction in neurological 

disorders – A review from students to students. J Neurochem. 2016 

Sep;138(6):805.  

88.  Legislação – DGAV [Internet]. [cited 2023 May 18]. Available from: 

https://www.dgav.pt/animais/conteudo/animais-para-fins-cientificos/bem-estar-

animal/bem-estar-introducao/legislacao/ 

89.  Parato J, Bartolini F. The Microtubule Cytoskeleton at the Synapse. Neurosci Lett. 

2021 May;753:135850.  

90.  Díaz-Valencia JD, Morelli MM, Bailey M, Zhang D, Sharp DJ, Ross JL. Drosophila 

katanin-60 depolymerizes and severs at microtubule defects. Biophys J. 2011 

May 18;100(10):2440–9.  

91.  Karabay A, Yu W, Solowska JM, Baird DH, Baas PW. Axonal growth is sensitive 

to the levels of katanin, a protein that severs microtubules. J Neurosci. 2004 Jun 

23;24(25):5778–88.  

92.  Zhao G, Oztan A, Ye Y, Schwarz TL. Kinetochore Proteins Have a Post-Mitotic 

Function in Neurodevelopment. Dev Cell. 2019 Mar 25;48(6):882.  

93.  Kim AH, Puram S V., Bilimoria PM, Ikeuchi Y, Keough S, Wong M, et al. A 

Centrosomal Cdc20-APC Pathway Controls Dendrite Morphogenesis in 

Postmitotic Neurons. Cell. 2009 Jan 23;136(2):322–36.  

94.  Yalgin C, Ebrahimi S, Delandre C, Yoong LF, Akimoto S, Tran H, et al. 

Centrosomin represses dendrite branching by orienting microtubule nucleation. 

Nat Neurosci. 2015 Oct 28;18(10):1437–45.  

 

 

 

 

 

 



   

 

59 
 

 

 

 

 

 

 

 

 

Supplementary information  

 

 

 

 

 

 

 

  



   

 

60 
 

 

 

 

 

 

 

 

 

Supplementary information I 

Antibodies and D. melanogaster stocks 
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Table 1 - List of primary antibodies used in this study. 

Primary Ab 
Concentration 

used 
Source 

Mouse anti-Discs large 
(4F3) 

1:500 
Developmental Studies 

Hybridoma Bank 

Rabbit anti-GFP 1:3000  

Mouse anti-alpha-
tubulin (12G10) 

1:100 
Developmental Studies 

Hybridoma Bank 

Mouse anti-Futsch 
(22C10) 

1:50 
Developmental Studies 

Hybridoma Bank 

Mouse anti-beta-
tubulin (E7) 

1:100 
Developmental Studies 

Hybridoma Bank 

Rabbit anti-DLG 1:100  

 

Table 2 - List of secondary antibodies used in this study. 

Secondary Ab 
Concentration 

used 
Source 

Goat anti-HRP Cy3 
(conjugated) 

1:500 
Jackson Immunoresearch 

Laboratories 

Donkey anti-Mouse 
Alexa Fluor 647 

1:500 
Jackson Immunoresearch 

Laboratories 

Goat anti-Rabbit Alexa 
Fluor 488 

1:500 
Jackson Immunoresearch 

Laboratories 
 

Table 3 - List of Drosophila melanogaster stocks used in this study. 

Fly name Genotype 
Source / 

Stock 
number 

UAS - EB1- GFP w[1118]; P{w[+mC]=UAS-EB1.EGFP.H}G BL 36861 

UAS - Shot - GFP w[*]; P{w[+mC]=UAS-Shot.L(C)-GFP}3 BL 29043 

UAS - Futsch - GFP w[*]; P{w[+mC]=UAS-EGFP.futsch.LC}42A BL 93063 

W1118 w[1118] BL 3605 

MHC - CD8 – GFP-sh - 
Gift from 
Dr. Brian 
McCabe 

Shot - RNAi 
y[1] v[1]; P{y[+t7.7] 
v[+t1.8]=TRiP.HMJ23381}attP40 

BL 64041 
(Ana 
Pimenta 
Marques 
lab gift) 

Tau - RNAi 
y[1] v[1]; P{y[+t7.7] 
v[+t1.8]=TRiP.HM05101}attP2 

BL 28891 

Futsch - RNAi 
y[1] v[1]; P{y[+t7.7] 
v[+t1.8]=TRiP.HMS02000}attP40 

BL 40834 

Katanin-60 - RNAi 
y[1] v[1]; P{y[+t7.7] 
v[+t1.8]=TRiP.JF03012}attP2 

BL 28375 

Spastin - RNAi 
y[1] v[1]; P{y[+t7.7] 
v[+t1.8]=TRiP.JF02724}attP2 

BL 27570 
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nSyb - GAL4 
w[1118]; P{w[+mC]=XP}nSyb[d02894]/TM6B, 
Tb[1] 

BL 19183 

UAS - CD4 -Tom 
w[1118]; PBac{y[+mDint2] w[+mC]=UAS-
CD4-tdTom}VK00033 

BL 35837 

 

Table 4 – List of drugs used in this study. 

Drug Source 

Paclitaxel (Taxol) Abcam 

Vinblastine Sigma 
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EB1 Time-lapse 
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Supplementary Data Figure 1 - Temporal time-lapse images of a potential ghost bouton (after high-
K+ stimulation). Neuronal membrane and EB1 were labeled with UAS-CD4-GFP and UAS-EB1-Ruby, both 
under the control of NSyb-Gal4 (pan-neuronal driver). Arrow indicates where the potential ghost bouton with EB1.  
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Supplementary information III 

Additional Data 
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Supplementary Data Figure 2 - Quantification of EB1 overexpression intensity in GBs after 
SS protocol. 18 GBs had low or moderate intensity of EB1 within; 51 GBs had high intensity of EB1 
within. n= 22 NMJs 

Supplementary Data Figure 3 - Quantification of Futsch overexpression intensity in 
GBs after SS protocol. 29 GBs had no detectable Futsch within. 71 GBs had low or moderate 

intensity of Futsch within. 12 GBs where found with high intensity of Futsch. n= 13 NMJs 

Supplementary Data Figure 4 - Quantification of Shot overexpression intensity in GBs 
after SS protocol. 9 GBs had no detectable Shot within. 68 GBs had low or moderate intensity of 

Shot within. 2 GBs where found with high intensity of Shot. n= 13 NMJs 
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Supplementary Data Figure 5 - Quantification of GBs and NMJs area measurement after 
short stimulation protocol. On the left panel, n=27 NMJs for nSyb;+ and n=20 NMJs for 

nSyb;Mis12-IR. Statistical significance was determined using the nonparametric Mann-Whitney 
test; ***p=0.0003. On the right panel, n=27 NMJs for nSyb;+ and n=20 NMJs for nSyb;Mis12-IR. 
Statistical significance was determined using the Unpaired t test; ****p<0,0001. 

Supplementary Data Figure 6 - Quantification of GBs and NMJs area measurement 
after short stimulation protocol. On the left panel, n=27 NMJs for nSyb;+ and n=17 NMJs for 

nSyb;Cnn-IR. Statistical significance was determined using the nonparametric Mann-Whitney 
test; ***p=0.0005. On the right panel, n=27 NMJs for nSyb;+ and n=17NMJS for nSyb;Mis12-IR. 
Statistical significance was determined using the Unpaired t test; not significant (ns). 


